Session Recording 2003
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What’s new</td>
<td>3</td>
</tr>
<tr>
<td>Fixed issues</td>
<td>3</td>
</tr>
<tr>
<td>Known issues</td>
<td>4</td>
</tr>
<tr>
<td>Third party notices</td>
<td>4</td>
</tr>
<tr>
<td>System requirements</td>
<td>5</td>
</tr>
<tr>
<td>Get started</td>
<td>7</td>
</tr>
<tr>
<td>Plan your deployment</td>
<td>8</td>
</tr>
<tr>
<td>Security recommendations</td>
<td>11</td>
</tr>
<tr>
<td>Scalability considerations</td>
<td>17</td>
</tr>
<tr>
<td>Install, upgrade, and uninstall</td>
<td>29</td>
</tr>
<tr>
<td>Dynamic session recording</td>
<td>69</td>
</tr>
<tr>
<td>Configure</td>
<td>73</td>
</tr>
<tr>
<td>Configure the connection to the Session Recording Server</td>
<td>74</td>
</tr>
<tr>
<td>Authorize users</td>
<td>75</td>
</tr>
<tr>
<td>Configure policies</td>
<td>77</td>
</tr>
<tr>
<td>Specify where recordings are stored</td>
<td>99</td>
</tr>
<tr>
<td>Specify file size for recordings</td>
<td>100</td>
</tr>
<tr>
<td>Customize notification messages</td>
<td>101</td>
</tr>
<tr>
<td>Enable or disable recording</td>
<td>102</td>
</tr>
<tr>
<td>Enable or disable digital signing</td>
<td>103</td>
</tr>
<tr>
<td>Administrator Logging</td>
<td>104</td>
</tr>
<tr>
<td>Database high availability</td>
<td>106</td>
</tr>
<tr>
<td>Load balancing</td>
<td>107</td>
</tr>
</tbody>
</table>

© 1999-2020 Citrix Systems, Inc. All rights reserved.
Session Recording 2003

Change your communication protocol 116
Configure CEIP 118
Log events 122
View recordings 127
Launch the Session Recording Player 128
Enable or disable live session playback and playback protection 129
Open and play recordings 130
Highlight idle periods 136
Cache recordings 137
Use events and bookmarks 137
Search for recordings 140
Session Recording web player 141
Troubleshoot 158
Installation of Server components fails 159
Test connection to the Database fails during install 159
Agent cannot connect to the Server 159
Server cannot connect to the Database 161
Sessions are not recording 162
Unable to view live session playback 163
Recordings are corrupted or incomplete 163
Verify component connections 164
Search for recordings using the Player fails 167
Manage your database records 169
What’s new

March 26, 2020

What’s new in 2003

This release includes the following new features:

Record idle events and highlight idle periods in the web player

Session Recording can now record idle events and highlight idle periods in the Session Recording web player. The feature is enabled by default. For more information, see Record idle events and highlight idle periods.

Comment on recordings during playback

During session playback in the Session Recording web player, you can leave comments about recordings and set comment severities. All comments about a recording are listed among logged events in the web player. You can view and delete all comments that you and other viewers left. For more information, see Comment on recordings.

Fixed issues

March 26, 2020

Compared to: Session Recording 1912

Session Recording 2003 contains the following fixes:

• The same record appears twice on the “Record Reason Logging” page of Session Recording Administrator Logging. [SRT-4003]

• If you have the TS key created under HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SessionEvents, certain events are not captured regardless of the key values. To capture various events properly, use the Session Recording Policy Console to set event logging policies. [SRT-4168]
**Known issues**

April 16, 2020

The following issues have been identified in this release:

- An error occurs when you attempt to play recordings by using the web player in Internet Explorer. To make the web player work properly in Internet Explorer, contact Citrix Support for a workaround. Alternatively, you can use Google Chrome or Firefox. [SRT-4612]

- Rules of Session Recording custom policies might be lost after you update Session Recording from the version included in the XenApp and XenDesktop 7.6 LTSR to the latest version. As a workaround, before updating Session Recording to the latest version, update the software to the version included in the latest CU of the XenApp and XenDesktop 7.15 LTSR and then update it to the latest release. [SRT-4546]

- A black screen might appear when the web player plays back a recording with ultra-high resolution. [SRT-4022]

- The same record appears twice on the “Record Reason Logging” page of Session Recording Administrator Logging. [SRT-4003]

- When Machine Creation Services (MCS) or Provisioning Services (PVS) creates multiple VDAs with the configured master image and Microsoft Message Queuing ( MSMQ) installed, those VDAs can have the same QMId under certain conditions. This case might cause various issues, for example:
  - Sessions might not be recorded even if the recording agreement is accepted.
  - The Session Recording Server might not be able to receive session logoff signals and therefore, sessions might always be in a live state.

For information about a workaround, see Install, upgrade, and uninstall. [#528678]

**Third party notices**

March 26, 2020

**Session Recording Version 2003 (PDF Download)**

This release of Session Recording can include third party software licensed under the terms defined in this document.
Session Recording 2003

System requirements

March 26, 2020
The Session Recording components include the Session Recording Administration components, the Session Recording Agent, and the Session Recording Player. You can install the Session Recording Administration components (Session Recording Database, Session Recording Server, and Session Recording Policy Console) on a single server or on different servers. The following section details the requirements for each of the Session Recording components.

For more information about using this Current Release (CR) in a Long Term Service Release (LTSR) environment and other frequently asked questions, see Knowledge Center article.

Session Recording Database

Supported operating systems:

- Windows Server 2019
- Windows Server 2016
- Windows Server 2012 R2

Supported Microsoft SQL Server versions:

- Microsoft SQL Server 2017 Enterprise, Express, and Standard editions
- Microsoft SQL Server 2016 SP2 Enterprise, Express, and Standard editions
- Microsoft SQL Server 2016 SP1 Enterprise, Express, and Standard editions
- Microsoft SQL Server 2014 SP2 Enterprise, Express, and Standard editions
- Microsoft SQL Server 2012 SP3 Enterprise, Express, and Standard editions
- Microsoft SQL Server 2008 R2 SP3 Enterprise, Express, and Standard editions

Requirement: .NET Framework 4.7.2

Session Recording Server

Supported operating systems:

- Windows Server 2019
- Windows Server 2016
- Windows Server 2012 R2

Other requirements:

- Internet Information Services (IIS) 10, 8.5, 8.0, or 7.5
- .NET Framework Version 4.7.2
- If the Session Recording Server uses HTTPS as its communications protocol, add a valid certificate. Session Recording uses HTTPS by default, which Citrix recommends.
- Microsoft Message Queuing (MSMQ), with Active Directory integration disabled and MSMQ HTTP support enabled.
- For Administrator Logging: Latest version of Chrome, Firefox, or Internet Explorer 11

**Session Recording Policy Console**

Supported operating systems:

- Windows Server 2019
- Windows Server 2016
- Windows Server 2012 R2

Requirement: .NET Framework 4.7.2

**Session Recording Agent**

Install the Session Recording Agent on every Windows Virtual Delivery Agent (VDA) on which you want to record sessions.

Supported operating systems:

- Windows Server 2019
- Windows Server 2016
- Windows Server 2012 R2
- Windows 10, minimum version 1607
- Windows 10 Enterprise for Virtual Desktops

Requirements:

- Citrix Virtual Apps and Desktops 7 2003 with Premium license
- XenApp and XenDesktop 7.15 LTSR CU5 with Platinum license
- .NET Framework 4.7.2
- Microsoft Message Queuing (MSMQ), with Active Directory integration disabled and MSMQ HTTP support enabled

**Session Recording Player**

Supported operating systems:

- 64-bit Windows 10, minimum version 1607

© 1999-2020 Citrix Systems, Inc. All rights reserved.
Session Recording 2003

Requirement: .NET Framework 4.7.2

**Note:** On 32-bit Windows 10, you can install the Player only by using the SessionRecordingPlayer.msi file. The msi file is located on the Citrix Virtual Apps and Desktops ISO under \layout\image-full\x86\Session Recording.

For optimal results, install the Session Recording Player on a workstation with:

- Screen resolution of 1024 x 768
- Color depth of at least 32-bit
- 2 GB RAM minimum; more RAM and CPU/GPU resources can improve performance when playing graphics-intensive recordings, especially when recordings contain many animations

The seek response time depends on the size of the recording and your machine’s hardware specifications.

**Get started**

November 27, 2019

Session Recording consists of five components:

- **Session Recording Agent.** A component installed on each VDA for multi-session OS or single-session OS to enable recording. It is responsible for recording session data.
- **Session Recording Server.** A server that hosts:
  - The Broker. An IIS 6.0+ hosted Web application that handles the search queries and file download requests from the Session Recording Player, handles policy administration requests from the Session Recording Policy Console, and evaluates recording policies for each Citrix Virtual Apps and Desktops session.
  - The Storage Manager. A Windows service that manages the recorded session files received from each Session Recording-enabled computer running Citrix Virtual Apps and Desktops.
  - Administrator Logging. An optional subcomponent installed with the Session Recording Server to log the administration activities. All the logging data is stored in a separate SQL Server database named CitrixSessionRecordingLogging by default. You can customize the database name.
- **Session Recording Player.** A user interface that users access from a workstation to play recorded session files.
- **Session Recording Database.** A component that manages the SQL Server database for storing recorded session data. When this component is installed, it creates a database named CitrixSessionRecording by default. You can customize the database name.
- **Session Recording Policy Console.** A console used to create policies to specify which sessions are recorded.
This illustration shows the Session Recording components and their relationship with each other:

In the deployment example illustrated here, the Session Recording Agent, Session Recording Server, Session Recording Database, Session Recording Policy Console, and Session Recording Player all reside behind a security firewall. The Session Recording Agent is installed on a VDA for multi-session OS or single-session OS. A second server hosts the Session Recording Policy Console, a third server acts as the Session Recording Server, and a fourth server hosts the Session Recording Database. The Session Recording Player is installed on a workstation. A client device outside the firewall communicates with the VDA for multi-session OS on which the Session Recording Agent is installed. Inside the firewall, the Session Recording Agent, Session Recording Policy Console, Session Recording Player, and Session Recording Database all communicate with the Session Recording Server.

Plan your deployment

December 18, 2019
Limitations and caveats

Session Recording does not support Desktop Composition Redirection (DCR) display mode. By default, Session Recording disables DCR in a session if the session is to be recorded by recording policy. You can configure this behavior in Session Recording Agent properties.

If some URLs are configured in the browser content redirection policy that was introduced in Version 7.16 of the Windows VDA, graphics activities of browsing these URLs in the Internet Explorer browser cannot be recorded.

Session Recording does not support the Framehawk display mode. Sessions in Framehawk display mode cannot be recorded and played back correctly. Sessions recorded in Framehawk display mode might not contain the sessions' activities.

Session Recording cannot record the Lync webcam video when using the HDX RealTime Optimization Pack.

Depending upon your environment, you can deploy the Session Recording components in different scenarios.

A Session Recording deployment is not limited to a single site. Except the Session Recording Agent, all components are independent of the server site. For example, you can configure multiple sites to use a single Session Recording Server.

Alternatively, if you have a large site with many agents and plan to record many graphically intense applications (for example, AutoCAD applications), or you have many sessions to record, a Session Recording Server can experience a high performance demand. To alleviate performance issues, you can install multiple Session Recording Servers and enable the load balancing feature to make the Session Recording Servers work as a load balancing pool and to share the workload from different VDAs.

Suggested server site deployment

Use this type of deployment for recording sessions for one or more Sites. The Session Recording Agent is installed on each VDA in a Site. The Site resides in a data center behind a security firewall. The Session Recording Administration components (Session Recording Database, Session Recording Server, and Session Recording Policy Console) are installed on other servers and the Session Recording Player is installed on a workstation, all behind the firewall but not in the data center.
Important deployment notes

- To enable Session Recording components to communicate with each other, install them in the same domain or across trusted domains that have a transitive trust relationship. The system cannot be installed on a workgroup or across domains that have an external trust relationship.
- Considering its intense graphical nature and memory usage when playing back large recordings, Citrix does not recommend installing the Session Recording Player as a published application.
- The Session Recording installation is configured for TLS/HTTPS communication. Ensure that you install a certificate on the Session Recording Server and that the root certificate authority (CA) is trusted on the Session Recording components.
- If you install the Session Recording Database on a standalone server running SQL Server 2017 Express Edition, SQL Server 2016 Express Edition, SQL Server 2014 Express Edition, SQL Server 2012 Express Edition, or SQL Server 2008 R2 Express Edition, the server must have TCP/IP protocol enabled and SQL Server Browser service running. These settings are disabled by default, but they must be enabled for the Session Recording Server to communicate with the database. For information about enabling these settings, see the Microsoft articles Enable TCP/IP Network Protocol for SQL Server and SQL Server Browser Service.
- Consider the effects of session sharing when planning your Session Recording deployment. Session sharing for published applications can conflict with Session Recording policy rules for published applications. Session Recording matches the active policy with the first published application that a user opens. After the user opens the first application, any subsequent applications opened during the same session continue to follow the policy that is in force for the first
application. For example, if a policy states that only Microsoft Outlook should be recorded, the recording commences when the user opens Outlook. However, if the user opens a published Microsoft Word second (while Outlook is running), Word also is recorded. Conversely, if the active policy does not specify that Word should be recorded, and the user launches Word before Outlook (which should be recorded, according to the policy), Outlook is not recorded.

- Though you can install the Session Recording Server on a Delivery Controller, Citrix does not recommend that you do so because of performance issues.
- You can install the Session Recording Policy Console on a Delivery Controller.
- You can install both the Session Recording Server and the Session Recording Policy Console on the same system.
- Ensure that the NetBIOS name of the Session Recording Server does not exceed the limit of 15 characters. Microsoft has a 15-character limit on the host name length.
- PowerShell 5.1 or later is required for custom event logging. Upgrade PowerShell if you install the Session Recording Agent on Windows Server 2012 R2 that has PowerShell 4.0 installed. Failure to comply can cause failed API calls.

**Security recommendations**

February 27, 2020

Session Recording is deployed within a secure network and accessed by administrators, and as such, is secure. Out-of-the-box deployment is simple and security features such as digital signing and encryption can be configured optionally.

Communication between Session Recording components is achieved through Internet Information Services (IIS) and Microsoft Message Queuing (MSMQ). IIS provides the web services communication link between Session Recording components. MSMQ provides a reliable data transport mechanism for sending recorded session data from the Session Recording Agent to the Session Recording Server.

**Warning:**

Editing the registry incorrectly can cause serious problems that might require you to reinstall your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the registry before you edit it.

Consider these security recommendations when planning your deployment:

- Ensure that you properly isolate the different administrator roles in the corporate network, in the Session Recording system, or on individual machines. By not doing so, security threats that can impact the system functionality or abuse the system might occur. Citrix recommends that
you assign different administrator roles to different persons or accounts. Do not allow general session users to have administrator privileges to the VDA system.

- Citrix Virtual Apps and Desktops administrators do not grant VDA local administrator role to any users of published apps or desktops. If the local administrator role is a requirement, protect the Session Recording Agent components by using Windows mechanisms or third-party solutions.
- Separately assign the Session Recording database administrator and Session Recording policy administrator.
- Citrix recommends that you do not assign VDA administrator privileges to general session users, especially when using Remote PC Access.
- Session Recording Server local administration account must be strictly protected.
- Control access to machines where the Session Recording Player is installed. If a user is not authorized for the Player role, do not grant that user local administrator role for any player machine. Disable anonymous access.
- Citrix recommends using a physical machine as a storage server for Session Recording.

- Session Recording records session graphics activities without regard to the sensitivity of the data. Under certain circumstances, sensitive data (including but not limited to user credentials, privacy information, and third-party screens) might be recorded unintentionally. Take the following measures to prevent risks:
  - Disable core memory dump for VDAs unless for specific troubleshooting cases.
    To disable core memory dump:
    1. Right-click My Computer, and then select Properties.
    2. Click the Advanced tab, and then under Startup and Recovery, click Settings.
    3. Under Write Debugging Information, select (none).
    See the Microsoft article at https://support.microsoft.com/en-us/kb/307973.
- Session owners notify attendees that online meetings and remote assistance software might be recorded if a desktop session is being recorded.
- Ensure that logon credentials or security information does not appear in all local and Web applications published or used inside the corporation. Otherwise, they are recorded by Session Recording.
- Close any application that might expose sensitive information before switching to a remote ICA session.
- Citrix recommends only automatic authentication methods (for example, single sign-on, smartcard) for accessing published desktops or Software as a Service (SaaS) applications.

- Session Recording relies on certain hardware and hardware infrastructure (for example, corporate network devices, operation system) to function properly and to meet security needs. Take measures at the infrastructure levels to prevent damage or abuse to those infrastructures and make the Session Recording function secure and reliable.
  - Properly protect and keep network infrastructure supporting Session Recording available.
Citrix recommends using a third-party security solution or Windows mechanism to protect Session Recording components. Session Recording components include:

* On the Session Recording Server
  - Processes: SsRecStoragemanager.exe and SsRecAnalyticsService.exe
  - Services: CitrixSsRecStorageManager and CitrixSsRecAnalyticsService
  - All files in Session Recording Server installation folder
  - Registry values within HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server

* On the Session Recording Agent
  - Process: SsRecAgent.exe
  - Service: CitrixSmAudAgent
  - All files in Session Recording Agent installation folder
  - Registry values within HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Agent

- Set the access control list (ACL) for Message Queuing (MSMQ) on the Session Recording Server to restrict VDA or VDI machines that can send MSMQ data to the Session Recording Server and prevent unauthorized machines from sending data to the Session Recording Server.

1. Install server feature Directory Service Integration on each Session Recording Server and VDA or VDI machine where Session Recording is enabled. Then restart the Message Queuing service.
2. From the Windows Start menu on each Session Recording Server, open Administrative Tools > Computer Management.
4. Click the private queue citrixsmauddata to open the Properties page and select the Security tab.
5. Add the computers or security groups of the VDAs that send MSMQ data to this server and grant them the **Send Message** permission.
• Properly protect the event log for the Session Record Server and Session Recording Agents. We recommend using a Windows or third-party remote logging solution to protect the event log or redirect the event log to the remote server.

• Ensure that servers running the Session Recording components are physically secure. If possible, lock these computers in a secure room to which only authorized personnel can gain direct access.

• Isolate servers running the Session Recording components on a separate subnet or domain.

• Protect the recorded session data from users accessing other servers by installing a firewall between the Session Recording Server and other servers.

• Keep the Session Recording Administration Server and SQL database up-to-date with the latest security updates from Microsoft.

• Restrict non-administrators from logging on to the administration machine.

• Strictly limit who is authorized to make recording policy changes and view recorded sessions.

• Install digital certificates, use the Session Recording file signing feature, and set up TLS communications in IIS.

• Set up MSMQ to use HTTPS as its transport. The way is to set the MSMQ protocol listed in Session
**Recording Agent Properties** to HTTPS. For more information, see Troubleshoot MSMQ.

- Use TLS 1.1 or TLS 1.2 (recommended) and disable SSLv2, SSLv3, TLS 1.0 on the Session Recording Server and Session Recording Database. For more information, see the Microsoft article at http://support.microsoft.com/default.aspx?scid=kb;en-us;187498.

Disable RC4 cipher suites for TLS on the Session Recording Server and Session Recording Database:

1. Using the Microsoft Group Policy Editor, navigate to Computer Configuration > Administrative Templates > Network > SSL Configuration Settings.
2. Set the SSL Cipher Suite Order policy to Enabled. By default, this policy is set to Not Configured.
3. Remove any RC4 cipher suites.

- Use playback protection. Playback protection is a Session Recording feature that encrypts recorded files before they are downloaded to the Session Recording Player. By default, this option is enabled and is in Session Recording Server Properties.
- Follow NSIT guidance for cryptographic key lengths and cryptographic algorithms.
- Configure TLS 1.2 support for Session Recording.
  - Citrix recommends using TLS 1.2 as the communication protocol to ensure the end-to-end security of the Session Recording components.

**To configure TLS 1.2 support of Session Recording:**

1. Log on to the machine hosting the Session Recording Server. Install the proper SQL Server client component and driver, and set strong cryptography for .NET Framework (version 4 or later).
   a. Install the Microsoft ODBC Driver 11 (or a later version) for SQL Server.
   b. Apply the latest hotfix rollup of .NET Framework.
   c. Install ADO.NET – SqlClient based on your version of .NET Framework. For more information, see https://support.microsoft.com/en-us/kb/3135244.
   d. Add a DWORD value SchUseStrongCrypto = 1 under HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\NetFramework\v4.0.30319.
   e. Restart the machine.
2. Log on to the machine hosting the Session Recording Policy Console. Apply the latest hotfix rollup of .NET Framework, and set strong cryptography for .NET Framework (version 4 or later). The method for setting strong cryptography is same as substeps 1-d and 1-e. You can omit these steps if you choose to install the Session Recording Policy Console on the same computer as the Session Recording Server.

To configure the TLS 1.2 support for SQL Server with versions earlier than 2016, see https://support.microsoft.com/en-us/kb/3135244. To use TLS 1.2, configure HTTPS as the communication protocol for the Session Recording components.

For information about configuring the Session Recording security features, see Configuring Security
Session Recording 2003

Features of Session Recording.

Scalability considerations

March 24, 2020

Session Recording is a highly scalable system that handles thousands or tens of thousands of sessions. Installing and running Session Recording requires few extra resources beyond what is necessary to run Citrix Virtual Apps and Desktops. However, if you plan to use Session Recording to record a large number of sessions or if the sessions you plan to record can result in large session files (for example, graphically intense applications), consider the performance of your system when planning your Session Recording deployment.

This article explains how Session Recording achieves high scalability and how you can get the most out of your recording system at a lowest cost.

Why Session Recording scales well

There are two major reasons that Session Recording scales well compared with competitive products:

- Small file size
  
  A recorded session file made with Session Recording is highly compact. It is many orders of magnitude smaller than an equivalent video recording made with solutions that screen-scrape. The network bandwidth, disk space, and disk IOPS required to transport and store each Session Recording file is typically at least 10 times less than an equivalent video file.

  The small size of recorded session files means faster and smoother rendering of video frames. Recordings are also completely lossless and have no pixelation that is common in most compact video formats. Text in recordings is easy to read during playback as it is in the original sessions. To maintain small file sizes, Session Recording does not record key frames within the files.

- Low processing required to generate files

  A recorded session file contains the ICA protocol data for a session that is extracted virtually in its native format. This means the file captures the ICA protocol data stream that is used to communicate with Citrix Workspace app. There is no need to run expensive transcoding or encoding software components to change the format of data in real time. The low amount of processing is also important for VDA scalability and ensures the end-user experience is maintained when many sessions are recorded from the same VDA.
Moreover, only those ICA virtual channels that are capable of being played back are recorded, which results in a further optimization. For example, the printer and client drive mapping channels are not recorded because they can generate high volumes of data without any benefit in video playback.

**Estimate data input and processing rates**

The Session Recording Server is the central collection point for recorded session files. Each machine that is running a multi-session OS VDA with Session Recording enabled sends recorded session data to the Session Recording Server. Session Recording can handle high volumes of data and can tolerate bursts and faults, but there are physical limits on how much data any one server can handle.

Consider how much data you will be sending to each Session Recording Server and how quickly the servers can process and store this data. The rate at which your system can store incoming data must be higher than the data input rate.

To estimate your data input rate, multiply the number of sessions recorded by the average size of each recorded session and divide by the time for which you are recording sessions. For example, you might record 5,000 Microsoft Outlook sessions of 20 MB each over an 8-hour work day. In this case, the data input rate is approximately 3.5 Mbps. (5,000 sessions times 20 MB divided by 8 hours, divided by 3,600 seconds per hour.) A typical Session Recording Server connected to a 100 Mbps LAN with sufficient disk space to store the recorded data is capable of processing data at around 5.0 Mbps based on the physical limits imposed by disk and network IOPS. This is the processing rate. In the example, the processing rate (5.0 Mbps) is higher than the input rate (3.5 Mbps), so recording the 5,000 Outlook sessions is feasible.

Note that the amount of data per session varies greatly depending on what is being recorded, while other factors such as the screen resolution, color depth, and graphics mode also have impacts. A session running a CAD package where graphics activity is constantly high likely generates a much larger recording than a session in which the end user sends and receives emails in Microsoft Outlook. Therefore, recording the same number of CAD sessions can generate an extremely high input rate and require the use of more Session Recording Servers.

**Bursts and faults**

The previous example assumes a very simple uniform throughput of data but does not explain how the system deals with short periods of higher activity, known as bursts. A burst might occur when all users log on at the same time in the morning, known as the 9 o’clock rush, or when they receive the same email in their Outlook inbox at once. The 5.0 Mbps processing rate of the Session Recording Server is highly inadequate at dealing with this sudden demand.
The Session Recording Agent running on each VDA uses Microsoft Message Queuing (MSMQ) to send recorded data to the Storage Manager running on the central Session Recording Server. The data is sent in a store-and-forward manner similar to how an email is delivered between the sender, mail server, and the receiver. If the Session Recording Server or the network cannot handle the high rate of data in a burst, the recorded session data is temporarily stored until the backlog of data messages is cleared. The data message might be temporarily stored in the outgoing queue on the VDA if the network is congested, or stored on the Session Recording Server’s receiving queue if the data has traversed the network but the Storage Manager is still busy processing other messages.

MSMQ also serves as a fault tolerance mechanism. If the Session Recording Server goes down or the link is broken, recorded data is held in the outgoing queue on each VDA. When the fault is rectified, all queued data is sent together. The use of MSMQ also allows you to take a Session Recording Server offline for upgrade or maintenance without interrupting the recording of existing sessions and losing data.

The main limitation of MSMQ is that disk space for the temporary storage of data messages is finite. This limits how long a burst, fault, or maintenance event can last before data is eventually lost. The overall system can continue after data loss, but in this situation, individual recordings have chunks of data missing. A file with missing data is still playable but only up to the point where data was first lost.

Note the following:

- Adding more disk space to each server, especially the Session Recording Server, and making it available to MSMQ can increase the tolerance to bursts and faults.

- It is important to configure the Message Life setting for each Session Recording Agent to an appropriate level (on the Connections tab in Session Recording Agent Properties). The default value of 7,200 seconds (two hours) means that each recorded data message has two hours to reach the Storage Manager before it is discarded and recording files are damaged. With more disk space available (or fewer sessions to record), you can choose to increase this value. The maximum value is 365 days.

The other limitation with MSMQ is that when data backlogs, there is extra disk IOPS in the queue to read and write data messages. Under normal conditions, the Storage Manager receives and processes data from the network directly without the data message ever being written to disk. Storing the data involves a single write operation to disk that appends the recorded session file. When data is backlogged, the disk IOPS is tripled: each message must be written to disk, read from disk, and written to file. As the Storage Manager is heavily IOPS bound, the processing rate of the Session Recording Server drops until the backlog of messages is cleared. To mitigate the effects of this extra IOPS, adopt the following recommendations:

- Ensure that the disk on which MSMQ stores messages is different from the recording file storage folders. Even though IOPS bus traffic is tripled, the drop in the true processing rate is never as severe.
• Have planned outages at off-peak times only. Depending on budget constraints, follow recognized approaches to building high availability servers. The approaches include the use of UPS, dual NICs, redundant switches, and hot swappable memory and disks.

Design for spare capacity

The data rate of recorded session data is unlikely to be uniform, bursts and faults might occur, and the clearing of message backlogs is expensive in IOPS. For this reason, design each Session Recording Server with plenty of spare capacity. Adding more servers or improving the specification of existing servers, as described in later sections, always gains you extra capacity. The general rule of thumb is to run each Session Recording server at a maximum of 50% of its total capacity. In the earlier example, if the server is capable of processing 5.0 Mbps, target the system to run only at 2.5 Mbps. Instead of recording 5,000 Outlook sessions that generate 3.5 Mbps on one Session Recording Server, reduce this to 3,500 sessions that generate only about 2.5 Mbps.

Backlogs and live playback

Live playback is when a reviewer opens a session recording for playback while the session is still active. During live playback, the Session Recording Agent responsible for the session switches to a streaming mode for that session, and recording data is sent immediately to the Storage Manager without internal buffering. Because the recording file is constantly updated, the Player can continue to be fed with the latest data from the live session. However, data sent from the Agent to the Storage Manager is through MSMQ, so the queuing rules described earlier apply. A problem can occur in this scenario. When MSMQ is backlogged, the new recorded data available for live playback is queued like all other data messages. The reviewer can still play the file, but viewing latest live recorded data is delayed. If live playback is an important feature for reviewers, ensure a low probability of backlog by designing spare capacity and fault tolerance into your deployment.

Citrix Virtual Apps and Desktops scalability

Session Recording never reduces session performance and never stops sessions in response to recorded data backlogs. Maintaining the end-user experience and single-server scalability is paramount in the design of the Session Recording system. If the recording system becomes irreversibly overloaded, recorded session data is discarded. Extensive scalability testing by Citrix reveals that the impact of recording ICA sessions on the performance and scalability of Citrix Virtual Apps and Desktops servers is low. The size of the impact depends on the platform, memory available, and the graphical nature of the sessions being recorded. With the following configuration, you can expect a single-server scalability impact of between 1% and 5%. In other words, if a server can host 100 users without Session Recording installed, it can host 95–99 users after installation:
- 64-bit server with 8 GB RAM running a multi-session OS VDA
- All sessions running Office productivity applications, such as Outlook and Excel
- The use of applications is active and sustained
- All sessions are recorded as configured by the Session Recording policies

If fewer sessions are recorded or session activity is less sustained and more sporadic, the impact is less. In many cases, the scalability impact is negligible and user density per server remains the same. As mentioned earlier, the low impact is due to the simple processing requirements of the Session Recording components installed on each VDA. Recorded data is simply extracted from the ICA session stack and sent as-is to the Session Recording Server through MSMQ. There is no expensive encoding of data.

There is a minor overhead of using Session Recording even when no sessions are recorded. Although the impact is low, if you are sure that no sessions will ever be recorded from a particular server, you can disable recording on that server. Removing Session Recording is one way of doing this. A less invasive approach is to clear the **Enable session recording for this VDA machine** check box on the **Session Recording** tab in Session Recording Agent Properties. If session recording is required in future, reselect this check box.

**Measuring throughput**

There are various ways to measure throughput of recorded session data from the sending VDA to the receiving Session Recording Server. One of the simplest and most effective approaches is to observe the size of files that are recorded, and the rate at which disk space on the Session Recording Server is being consumed. The volume of data written to disk closely reflects the volume of network traffic being generated. The Windows Performance Monitor tool (perfmon.exe) has a range of standard system counters that can be observed in addition to some counters provided by Session Recording. Counters can be used to measure throughput, and identify bottlenecks and system problems. The following table outlines some of the most useful performance counters.

<table>
<thead>
<tr>
<th>Performance Object</th>
<th>Counter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citrix Session Recording Agent</td>
<td>Active Recording Count</td>
<td>Indicates the number of sessions that are currently being recorded on a particular VDA.</td>
</tr>
<tr>
<td>Performance Object</td>
<td>Counter Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Citrix Session Recording</td>
<td>Bytes read from the Session</td>
<td>The number of bytes read from the kernel components responsible for acquiring session data. Useful for determining how much data a single VDA generates for all sessions recorded on that server.</td>
</tr>
<tr>
<td>Agent</td>
<td>Recording Driver</td>
<td></td>
</tr>
<tr>
<td>Citrix Session Recording</td>
<td>Active Recording Count</td>
<td>Similar to the Citrix Session Recording Agent counter except for the Session Recording Server. Indicates the total number of sessions currently being recorded for all servers.</td>
</tr>
<tr>
<td>Storage Manager</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Message bytes/sec</td>
<td>The throughput of all recorded sessions. Can be used to determine the rate at which the Storage Manager is processing data. If MSMQ is backlogged with messages, the Storage Manager runs at full speed. This value can be used to indicate the maximum processing rate of the Storage Manager.</td>
</tr>
<tr>
<td>LogicalDisk</td>
<td>Disk Write Bytes/sec</td>
<td>Can be used to measure disk write-through performance. This is important in achieving high scalability for the Session Recording Server. Performance of individual drives can also be observed.</td>
</tr>
<tr>
<td>Performance Object</td>
<td>Counter Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MSMQ Queue</td>
<td>Bytes in Queue</td>
<td>This counter can be used to determine the amount of data backlogged in the CitrixSmAudData message queue. If this value increases over time, the rate of recorded data received from the network is greater than the rate at which the Storage Manager can process data. This counter is useful for observing the effect of data bursts and faults.</td>
</tr>
<tr>
<td>MSMQ Queue</td>
<td>Message in Queue</td>
<td>Similar to the Bytes in Queue counter but measures the number of messages.</td>
</tr>
<tr>
<td>Network Interface</td>
<td>Bytes Total/sec</td>
<td>Can be measured on both sides of the link to observe how much data is generated when sessions are recorded. When measured on the Session Recording Server, this counter indicates the rate at which incoming data is received. Contrasts with the Citrix Session Recording Storage Manager/Message bytes/sec counter that measures the processing rate of data. If network rate is greater than this value, messages build in the message queue.</td>
</tr>
<tr>
<td>Processor</td>
<td>% Processor Time</td>
<td>Worth monitoring even though CPU is unlikely to be a bottleneck.</td>
</tr>
</tbody>
</table>
**Session Recording Server hardware**

You can increase the capacity of your deployment by carefully selecting the hardware used for the Session Recording Server. You have two choices: scaling up (by increasing the capacity of each server) or scaling out (by adding more servers). In making either of the choices, your aim is to increase scalability at a lowest cost.

**Scaling up**

When examining a single Session Recording Server, consider the following best practices to ensure optimal performance for available budgets. The system is dependent on IOPS. This ensures a high throughput of recorded data from the network onto the disk. So it is important to invest in appropriate network and disk hardware. For a high-performance Session Recording Server, a dual CPU or dual core CPU is recommended but little is gained from any higher specification. 64-bit processor architecture is recommended but an x86 processor type is also suitable. 4 GB of RAM is recommended but again there is little benefit from adding more.

**Scaling out**

Even with the best scaling up practices, there are limits to performance and scalability that can be reached with a single Session Recording Server when recording a large number of sessions. It might be necessary to add extra servers to meet the load. You can install more Session Recording Servers on different machines to have the Session Recording Servers work as a load balancing pool. In this type of deployment, the Session Recording Servers share the storage and the database. To distribute the load, point the Session Recording Agents to the load balancer that is responsible for the workload distribution.

**Network capacity**

A 100 Mbps network link is suitable for connecting a Session Recording Server. A Gb Ethernet connection might improve performance, but does not result in 10 times greater performance than a 100 Mbps link. In practice, the gain in throughput is significantly less.

Ensure that network switches used by Session Recording are not shared with third-party applications that might compete for available network bandwidth. Ideally, network switches are dedicated for use with the Session Recording Server. If network congestion proves to be the bottleneck, a network upgrade is a relatively inexpensive way to increase the scalability of the system.
Storage

Investment in disk and storage hardware is the single most important factor in server scalability. The faster that data can be written to disk, the higher the performance of the overall system. When selecting a storage solution, take more note of the write performance than the read performance.

Store data on a set of local disks controlled either as RAID by a local disk controller or as a SAN.

Note:

Storing data on a NAS based on file-based protocols such as SMB, CIFS, or NFS has serious performance and security implications. Never use this configuration in a production deployment of Session Recording.

For a local drive setup, aim for a disk controller with built-in cache memory. Caching allows the controller to use elevator sorting during write-back, which minimizes disk head movement and ensures write operations are completed without waiting for the physical disk operation to complete. This can improve write performance significantly at a minimal extra cost. Caching does however raise the problem of data loss after a power failure. To ensure the integrity of data and the file system, consider a battery backup facility for the caching disk controller, which ensures that, if power is lost, the cache is maintained and data is written to disk when power is eventually restored.

Consider using a suitable RAID storage solution. There are many RAID levels available depending on performance and redundancy requirements. The following table specifies each of the RAID levels and how applicable each standard is to Session Recording.

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Type</th>
<th>Minimum Number of Disks</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Striped set without parity</td>
<td>2</td>
<td>Provides high performance but no redundancy. Loss of any disk destroys the array. This is a low cost solution for storing recorded session files where the impact of data loss is low. Easy to scale up performance by adding more disks.</td>
</tr>
<tr>
<td>RAID Level</td>
<td>Type</td>
<td>Minimum Number of Disks</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------</td>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Mirrored set without parity</td>
<td>2</td>
<td>No performance gain over one disk, making it a relatively expensive solution. Use this solution only if a high level of redundancy is required.</td>
</tr>
<tr>
<td>RAID 3</td>
<td>Striped set with dedicated parity</td>
<td>3</td>
<td>Provides high write performance with redundancy characteristics similar to RAID 5. RAID 3 is recommended for video production and live streaming applications. As Session Recording is this type of application, RAID 3 is most highly recommended but it is not common.</td>
</tr>
</tbody>
</table>
### RAID Levels

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Type</th>
<th>Minimum Number of Disks</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 5</td>
<td>Striped set with distributed parity</td>
<td>3</td>
<td>Provides high read performance with redundancy but at the cost of slower write performance. RAID 5 is the most common for general purpose usages. But due to the slow write performance, RAID 5 is not recommended for Session Recording. RAID 3 can be deployed at a similar cost but with significantly better write performance.</td>
</tr>
<tr>
<td>RAID 10</td>
<td>Mirrored set and striped set</td>
<td>4</td>
<td>Provides performance characteristics of RAID 0 with redundancy benefits of RAID 1. An expensive solution that is not recommended for Session Recording.</td>
</tr>
</tbody>
</table>

RAID 0 and RAID 3 are the most recommended RAID levels. RAID 1 and RAID 5 are popular standards but are not recommended for Session Recording. RAID 10 does provide some performance benefits but is too expensive for the additional gain.

Decide on the type and specification of disk drives. IDE/ATA drives and external USB or Firewire drives are not suitable for use in Session Recording. The main choice is between SATA and SCSI. SATA drives provide reasonably high transfer rates at a reduced cost per MB compared with SCSI drives. However, SCSI drives provide better performance and are more common in server deployments. Server RAID solutions mostly support SCSI drives but some SATA RAID products are now available. When evaluating
the specifications of disk drive products, consider the rotational speed of disk and other performance characteristics.

Because the recording of thousands of sessions per day can consume significant amounts of disk space, you must choose between overall capacity and performance. From the earlier example, recording 5,000 Outlook sessions over an 8-hour work day consumes about 100 GB of storage space. To store 10 days’ worth of recordings (that is, 50,000 recorded session files), you need 1,000 GB (1 TB). This pressure on disk space can be eased by shortening the retention period before archiving or deleting old recordings. If 1 TB of disk space is available, a seven-day retention period is reasonable, ensuring disk space usage remains around 700 GB, with 300 GB remaining as a buffer for busy days. In Session Recording, the archiving and deleting of files is supported with the ICLDB utility and has a minimum retention period of two days. You can schedule a background task to run once a day at some off-peak time. For more information about the ICLDB commands and archiving, see Manage your database records.

The alternative to using local drive and controllers is to use a SAN storage solution based on block-level disk access. To the Session Recording Server, the disk array appears as a local drive. SANs are more expensive to set up, but as the disk array is shared, SANs do have the advantage of simplified and centralized management. There are two main types of SAN: Fibre Channel and iSCSI. iSCSI is essentially SCSI over TCP/IP and is gaining popularity over Fibre Channel since the introduction of Gb Ethernet.

**Database scalability**

The Session Recording Database requires Microsoft SQL Server 2017, Microsoft SQL Server 2016, Microsoft SQL Server 2014, Microsoft SQL Server 2012, or Microsoft SQL Server 2008 R2. The volume of data sent to the database is small because the database stores only metadata about the recorded sessions. The files of the recorded sessions themselves are written to a separate disk. Typically, each recorded session requires only about 1 KB of space in the database, unless the Session Recording Event API is used to insert searchable events to the session.

The Express Editions of Microsoft SQL Server 2017, Microsoft SQL Server 2016, Microsoft SQL Server 2014, Microsoft SQL Server 2012, and Microsoft SQL Server 2008 R2 impose a database size limitation of 10 GB. At 1 KB per recording session, the database can catalog about 4,000,000 sessions. Other editions of Microsoft SQL Server have no database size restrictions and are limited only by available disk space. As the number of sessions in the database increases, performance of the database and speed of searches diminishes only negligibly.

If you are not making customizations through the Session Recording Event API, each recorded session generates four database transactions: two when recording starts, one when the user logs on to the session being recorded, and one when recording ends. If you use the Session Recording Event API to customize sessions, each searchable event recorded generates one transaction. Because even the
most basic database deployment can handle hundreds of transactions per second, the processing load on the database is unlikely to be stressed. The impact is light enough that the Session Recording Database can run on the same SQL Server as other databases, including the Citrix Virtual Apps and Desktops data store database.

If your Session Recording deployment requires many millions of recorded sessions to be cataloged in the database, follow Microsoft guidelines for SQL Server scalability.

**Install, upgrade, and uninstall**

November 27, 2019

This chapter details how to install Session Recording by using the Citrix Virtual Apps and Desktops installer and how to upgrade and uninstall Session Recording. It contains the following sections:

- Installation checklist
- Install Session Recording
- Upgrade Session Recording
- Uninstall Session Recording

**Installation checklist**

You can install the Session Recording components by using the Citrix Virtual Apps and Desktops installer.

Before you start the installation, complete this list:

<table>
<thead>
<tr>
<th>Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the machines on which you want to install each Session Recording component. Ensure that each computer meets the hardware and software requirements for the component or components to be installed on it.</td>
</tr>
<tr>
<td>Use your Citrix account credentials to access the Citrix Virtual Apps and Desktops download page and download the product ISO file. Unzip the ISO file or burn a DVD of it.</td>
</tr>
</tbody>
</table>
Step | To use the TLS protocol for communication between the Session Recording components, install the correct certificates in your environment.
---|---
  | Install any hotfixes required for the Session Recording components. The hotfixes are available from the Citrix Support.
  | Configure Director to create and activate the Session Recording policies. For more information, see Configure Director to use the Session Recording Server.

Note:

- Citrix recommends that you divide the published applications into separate Delivery Groups based on your recording policies. Session sharing for published applications can conflict with the active policy if the applications are in the same Delivery Group. Session Recording matches the active policy with the first published application that a user opens. Starting with the 7.18 release, you can use the dynamic session recording feature to start or stop recording sessions at any time during the sessions. This feature can help to mitigate the conflict issue with the active policy. For more information, see Dynamic session recording.
- If you are planning to use Machine Creation Services (MCS) or Provisioning Services, prepare a unique QMId. Failure to comply can cause recording data losses.
- SQL Server requires that TCP/IP is enabled, the SQL Server Browser service is running, and Windows Authentication is used.
- To use HTTPS, configure server certificates for TLS/HTTPS.
- Ensure that users under Local Users and Groups > Groups > Users have write permission to the C:\windows\Temp folder.

Install Session Recording

Citrix recommends that you install the Session Recording Administration, Session Recording Agent, and Session Recording Player components on separate servers. The following procedures detail how to install these components:

Install the Session Recording Administration components
Install the Session Recording Agent
Install the Session Recording Player

Install the Session Recording Administration components

The Session Recording Administration components include the Session Recording Database, Session Recording Server, and Session Recording Policy Console. You can choose the component to install on a server.

Step 1: Download the product software and launch the wizard

1. If you have not downloaded the Citrix Virtual Apps and Desktops ISO yet, use your Citrix account credentials to access the Citrix Virtual Apps and Desktops download page and download the product ISO file. Unzip the ISO file or burn a DVD of it.
2. Use a local administrator account to log on to the machine where you are installing the Session Recording Administration components. Insert the DVD in the drive or mount the ISO file. If the installer does not launch automatically, double-click the AutoSelect application or the mounted drive. The installation wizard launches.

Step 2: Choose which product to install
Deliver applications and desktops to any user, anywhere, on any device.

- Hybrid cloud, cloud and enterprise provisioning
- Centralized and flexible management

Manage your delivery according to your needs:

<table>
<thead>
<tr>
<th>Citrix Virtual Apps</th>
<th>Deliver applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citrix Virtual Desktops</td>
<td>Deliver applications and desktops</td>
</tr>
</tbody>
</table>

Click **Start** next to the product to install **Citrix Virtual Apps** or **Citrix Virtual Desktops**.

**Step 3: Select Session Recording**
Select the **Session Recording** entry.

**Step 4: Read and accept the license agreement**
On the **Software License Agreement** page, read the license agreement, accept it, and then click **Next**.

**Step 5: Select the components to install and the installation location**
On the **Core Components** page:

- **Location**: By default, components are installed in C:\Program Files\Citrix. The default location works for most deployments. You can specify a custom installation location.

- **Component**: By default, all the check boxes next to the components that can be installed are selected. The installer knows whether it is running on a single-session OS or a multi-session OS. It allows the Session Recording Administration components to be installed on a multi-session OS only. It does not allow the Session Recording Agent to be installed on a machine that has no VDA installed in advance. If you install the Session Recording Agent on a machine that has no VDA installed in advance, the **Session Recording Agent** option is unavailable.

Select **Session Recording Administration** and click **Next**.
Step 6: Select the features to install
On the **Features** page:

- By default, all the check boxes next to the features that can be installed are selected. Installing all these features on a single server is fine for a proof of concept. However, for a large production environment, Citrix recommends that you install the Session Recording Policy Console on a separate server and the Session Recording Server, Session Recording Administrator Logging, and Session Recording Database on another separate server. The Session Recording Administrator Logging is an optional subfeature of the Session Recording Server. Select the Session Recording Server before you can select the Session Recording Administrator Logging.
- To add another feature on the same server after you select and install a feature or features on it, you can only run the msi package but cannot run the installer again.

Select the feature or features you want to install and click **Next**.

**Step 6.1: Install the Session Recording Database**

**Note:**

The Session Recording Database is not an actual database. It is a component responsible for
creating and configuring the required databases in the Microsoft SQL Server instance during installation. Session Recording supports three solutions for database high availability based on Microsoft SQL Server. For more information, see Database high availability.

There are typically three types of deployments for the Session Recording Database and Microsoft SQL Server:

- **Deployment 1**: Install the Session Recording Server and Session Recording Database on the same machine and the Microsoft SQL Server on a remote machine. *(Recommended)*
- **Deployment 2**: Install the Session Recording Server, Session Recording Database, and Microsoft SQL Server on the same machine.
- **Deployment 3**: Install the Session Recording Server on a machine and install both the Session Recording Database and Microsoft SQL Server on another machine. *(Not recommended)*

1. On the **Features** page, select **Session Recording Database** and click **Next**.

2. On the **Database and Server Configuration** page, specify the instance name and database name of the Session Recording Database and the computer account of the Session Recording Server. Click **Next**.
On the **Database and Server Configuration** page:

- **Instance name**: If the database instance is not a named instance as you configured when you set up the instance, you can use only the computer name of the SQL Server. If you have named the instance, use computer-name\instance-name as the database instance name. To determine the server instance name you are using, run `select @@servername` on the SQL Server. The return value is the exact database instance name. If your SQL server is configured to be listening on a custom port (other than the default port 1433), set the custom listener port by appending a comma to the instance name. For example, type **DXSBC-SRD-1,2433** in the **Instance name** text box, where 2433, following the comma, denotes the custom listener port.

- **Database name**: Type a custom database name in the **Database name** text box or use the default database name preset in the text box. Click **Test connection** to test the connectivity to the SQL Server instance and the validity of the database name.

  **Important:**

  A custom database name must contain only A-Z, a-z, and 0–9, and cannot exceed 123 characters.

- You must have the **securityadmin** and **dbcreator** server role permissions of the database. If
you do not have the permissions, you can:

- Ask the database administrator to assign the permissions for the installation. After the installation completes, the `securityadmin` and `dbcreator` server role permissions are no longer necessary and can be safely removed.

- Or, use the `SessionRecordingAdministrationx64.msi` package (unzip the ISO file, and you can find this msi package under \x64\Session Recording). During the msi installation, a dialog box prompts for the credentials of a database administrator with the `securityadmin` and `dbcreator` server role permissions. Type the correct credentials and then click OK to continue the installation.

The installation creates the Session Recording Database and adds the machine account of the Session Recording Server as `db_owner`.

- **Session Recording Server computer account:**
  - **Deployments 1 and 2:** Type `localhost` in the Session Recording Server computer account text box.
  - **Deployment 3:** Type the name of the machine hosting the Session Recording Server in the format of domain\computer-name. The Session Recording Server computer account is the user account for accessing the Session Recording Database.

**Note:**
Attempts to install the Session Recording Administration components can fail with error code 1603 when a domain name is set in the Session Recording Server computer account text box. As a workaround, type `localhost` or NetBIOS domain name\machine name in the Session Recording Server computer account text box. To get the NetBIOS domain name, run `$env:userdomain` in PowerShell or `echo %UserDomain%` in Command Prompt on the machine where the Session Recording Server is installed.

3. Review the prerequisites and confirm the installation.
The **Summary** page shows your installation choices. You can click **Back** to return to the earlier wizard pages and make changes, or click **Install** to start the installation.

4. Complete the installation.
The Finish Installation page shows green check marks for all the prerequisites and components that have been installed and initialized successfully.

Click Finish to complete the installation of the Session Recording Database.

**Step 6.2: Install the Session Recording Server**

1. On the Features page, select **Session Recording Server** and **Session Recording Administrator Logging**. Click Next.
The Session Recording Administrator Logging is an optional subfeature of the Session Recording Server. Select the Session Recording Server before you can select the Session Recording Administrator Logging. Citrix recommends that you install the Session Recording Administrator Logging together with the Session Recording Server at the same time. If you don’t want the Administrator Logging feature to be enabled, you can disable it on a later page. However, if you choose not to install this feature at the beginning but want to add it later, you can only manually add it by using the SessionRecordingAdministrationx64.msi package.

2. On the **Database and Server Configuration** page, specify the configurations.
On the **Database and Server Configuration** page:

- **Instance name**: Type the name of your SQL Server in the **Instance name** text box. If you are using a named instance, type computer-name\instance-name; otherwise, type computer-name only. If your SQL server is configured to be listening on a custom port (other than the default port 1433), set the custom listener port by appending a comma to the instance name. For example, type **DXSBC-SRD-1,2433** in the **Instance name** text box, where 2433, following the comma, denotes the custom listener port.

- **Database name**: Type a custom database name in the **Database name** text box or use the default database name **CitrixSessionRecording** that is preset in the text box.

- You must have the **securityadmin** and **dbcreator** server role permissions of the database. If you do not have the permissions, you can:
  - Ask the database administrator to assign the permissions for the installation. After the installation completes, the **securityadmin** and **dbcreator** server role permissions are no longer necessary and can be safely removed.
  - Or, use the SessionRecordingAdministrationx64.msi package to install the Session Recording Server. During the msi installation, a dialog box prompts for the credentials of a database administrator with the **securityadmin** and **dbcreator** server role permissions. Type the correct credentials and then click **OK** to continue the installation.
• After typing the correct instance name and database name, click **Test connection** to test the connectivity to the Session Recording Database.
• Type the Session Recording Server computer account, and then click **Next**.

3. On the **Administration Logging Configuration** page, specify configurations for the Administration Logging feature.

   On the **Administration Logging Configuration** page:

   • **The Administration Logging database is installed on the SQL Server instance**: This text box is not editable. The SQL Server instance name of the Administration Logging database is automatically grabbed from the instance name that you typed on the **Database and Server Configuration** page.

   • **Administrator Logging database name**: If you choose to install the Session Recording Administrator Logging feature, type a custom database name for the Administrator Logging database in this text box or use the default database name **CitrixSessionRecordingLogging** that is preset in the text box.

   **Note:**
The Administrator Logging database name must be different from the Session Recording Database name that is set in the Database name text box on the previous Database and Server Configuration page.

- After typing the Administrator Logging database name, click **Test connection** to test the connectivity to the Administrator Logging database.

- **Enable Administration Logging**: By default, the Administration Logging feature is enabled. You can disable it by clearing the check box.

- **Enable mandatory blocking**: By default, mandatory blocking is enabled. The normal features might be blocked if logging fails. You can disable mandatory blocking by clearing the check box.

Click **Next** to continue the installation.

4. Review the prerequisites and confirm the installation.

The **Summary** page shows your installation choices. You can click **Back** to return to the earlier wizard pages and make changes, or click **Install** to start the installation.

5. Complete the installation.
The Finish Installation page shows green check marks for all the prerequisites and components that have been installed and initialized successfully.

Click Finish to complete the installation of the Session Recording Server.

Note:

The Session Recording Server default installation uses HTTPS/TLS to secure communications. If TLS is not configured in the default IIS site of the Session Recording Server, use HTTP. To do so, cancel the selection of SSL in the IIS Management Console by navigating to the Session Recording Broker site, opening the SSL settings, and clearing the Require SSL check box.

Step 6.3: Install the Session Recording Policy Console

1. On the Features page, select Session Recording Policy Console and click Next.
2. Review the prerequisites and confirm the installation.
The **Summary** page shows your installation choices. You can click **Back** to return to the earlier wizard pages and make changes, or click **Install** to start the installation.

3. Complete the installation.
The **Finish Installation** page shows green check marks for all the prerequisites and component that have been installed and initialized successfully.

Click **Finish** to complete your installation of the Session Recording Policy Console.

**Step 7: Install Broker_PowerShellSnapIn_x64.msi**

**Important:**

To use the Session Recording Policy Console, you must have the Broker PowerShell Snap-in (Broker_PowerShellSnapIn_x64.msi) installed. The snap-in cannot be automatically installed by the installer. Locate the snap-in on the Citrix Virtual Apps and Desktops ISO (\layout\image-full\x64\Citrix Desktop Delivery Controller) and follow the instructions for installing it manually. Failure to comply can cause an error.

**Install the Session Recording Agent**

Install the Session Recording Agent on the VDA or VDI machine on which you want to record sessions.
Step 1: Download the product software and launch the wizard

Use a local administrator account to log on to the machine where you are installing the Session Recording Agent component. Insert the DVD in the drive or mount the ISO file. If the installer does not launch automatically, double-click the **AutoSelect** application or the mounted drive.

The installation wizard launches.

Step 2: Choose which product to install

Click **Start** next to the product to install **Citrix Virtual Apps** or **Citrix Virtual Desktops**.

Step 3: Select Session Recording
Select the **Session Recording** entry.

**Step 4: Read and accept the license agreement**
On the **Software License Agreement** page, read the license agreement, accept it, and then click **Next**

**Step 5: Select the component to install and the installation location**
Session Recording 2003

Select Session Recording Agent and click Next.

Step 6: Specify the Agent configuration
On the **Agent Configuration** page: If you have installed the Session Recording Server in advance, type the computer name of the machine where you installed the Session Recording Server and the protocol and port information for the connection to the Session Recording Server. If you have not installed Session Recording yet, you can change such information later in **Session Recording Agent Properties**.

**Note:**

There is a limitation with the test connection function of the installer. It does not support the “HTTPS requires TLS 1.2” scenario. If you use the installer in this scenario, test connection fails but you can ignore the failure and click **Next** to continue the installation. It does not affect normal functioning.

**Step 7: Review the prerequisites and confirm the installation**
The Summary page shows your installation choices. You can click Back to return to the earlier wizard pages and make changes, or click Install to start the installation.

**Step 8: Complete the installation**
The Finish Installation page shows green check marks for all the prerequisites and components that have been installed and initialized successfully.

Click Finish to complete the installation of the Session Recording Agent.

Note:
When Machine Creation Services (MCS) or Provisioning Services (PVS) creates multiple VDAs with the configured master image and Microsoft Message Queuing (MSMQ) installed, those VDAs can have the same QMId under certain conditions. This case might cause various issues, for example:

- Sessions might not be recorded even if the recording agreement is accepted.
- The Session Recording Server might not be able to receive session logoff signals and therefore, sessions might always be in Live status.

As a workaround, create a unique QMId for each VDA and it differs depending on the deployment methods.

No extra actions are required if single-session OS VDAs with the Session Recording Agent installed are created with PVS 7.7 or later and MCS 7.9 or later in the static desktop mode that is, for example, configured to make all changes persistent with a separate Personal vDisk or the local disk of
your VDA.

For multi-session OS VDAs created with MCS or PVS and single-session OS VDAs that are configured to discard all changes when a user logs off, use the GenRandomQMID.ps1 script to change the QMId on system startup. Change the power management strategy to ensure that enough VDAs are running before user logon attempts.

To use the GenRandomQMID.ps1 script, do the following:

1. Ensure that the execution policy is set to **RemoteSigned** or **Unrestricted** in PowerShell.

   ```powershell
   Set-ExecutionPolicy RemoteSigned
   ```

2. Create a scheduled task, set the trigger as on system startup, and run with the SYSTEM account on the PVS or MCS master image machine.

3. Add the command as a startup task.

   ```powershell
   powershell .exe -file C:\GenRandomQMID.ps1
   ```

**Summary of the GenRandomQMID.ps1 script:**

1. Remove the current QMId from the registry.
2. Add `SysPrep = 1` to `HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSMQ\Parameters`.
3. Stop related services, including CitrixSmAudAgent and MSMQ.
4. To generate a random QMId, start the services that stopped previously.

   **Example GENRANDOMQMID.PS1:**

   ```powershell
   # Remove old QMId from registry and set SysPrep flag for MSMQ
   Remove-ItemProperty -Path HKLM:Software\Microsoft\MSMQ\Parameters\MachineCache -Name QMId -Force
   Set-ItemProperty -Path HKLM:Software\Microsoft\MSMQ\Parameters -Name "SysPrep" -Type DWord -Value 1
   # Get dependent services
   $depServices = Get-Service -name MSMQ -dependentservices | Select -Property Name
   # Restart MSMQ to get a new QMId
   Restart-Service -force MSMQ
   # Start dependent services
   ```
if ($depServices -ne $null) {
    foreach ($depService in $depServices) {
        $startMode = Get-WmiObject win32_service -filter "NAME = '$($depService.Name)'") | Select -Property StartMode
        if ($startMode.StartMode -eq "Auto") {
            Start-Service $depService.Name
        }
    }
}

Automate installation
Session Recording supports silent installation with options. Write a script that uses silent installation and run the relevant commands.

Automate installation of the Session Recording Administration components
For example, the following command installs the Session Recording Administration components and creates a log file to capture the installation information.

```
Msiexec /i "c:\SessionRecordingAdministrationx64.msi" ADDLOCAL="SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase" DATABASEINSTANCE="WNBIO-SRD-1" DATABASENAME="CitrixSessionRecording" LOGGINGDATABASENAME="CitrixSessionRecordingLogging" DATABASEUSER="localhost" /q /l*v "yourinstallationlog"
```

Note:
The SessionRecordingAdministrationx64.msi file is located on the Citrix Virtual Apps and Desktops ISO under \layout\image-full\x64\Session Recording.

Where:

- **ADDLOCAL** provides the features for you to select. You can select more than one option. SsRecServer is the Session Recording Server. PolicyConsole is the Session Recording Policy Console.
SsRecLogging is the Administrator Logging feature. StorageDatabase is the Session Recording Database. Session Recording Administrator Logging is an optional subfeature of the Session Recording Server. Select the Session Recording Server before you can select Session Recording Administrator Logging.

- **DATABASEINSTANCE** is the instance name of the Session Recording database. For example, `.\SQLEXPRESS`, `computer-name\SQLEXPRESS`, `computer-name`
- **DATABASENAME** is the database name of the Session Recording database.
- **LOGGINGDATABASENAME** is the name of the Administrator Logging database.
- **DATABASEUSER** is the computer account of the Session Recording Server.
- /q specifies quiet mode.
- /l*v specifies verbose logging.
- **yourinstallationlog** is the location of your installation log file.

### Automate installation of the Session Recording Player and web player

For example, the following commands install the Session Recording Player and web player, respectively.

```plaintext
1 msiexec /i "c:\SessionRecordingPlayer.msi" /q /l*\vx "yourinstallationlog"
```

```plaintext
1 msiexec /i "c:\SessionRecordingWebPlayer.msi" /q /l*v x "yourinstallationlog"
```

**Note:**

The SessionRecordingPlayer.msi file is located on the Citrix Virtual Apps and Desktops ISO under \layout\image-full\x86\Session Recording.

The SessionRecordingWebPlayer.msi file is located on the Citrix Virtual Apps and Desktops ISO under \layout\image-full\x64\Session Recording.

Where:

- /q specifies quiet mode.
- /l*v specifies verbose logging.
- **yourinstallationlog** is the location of your installation log file.

### Automate installation of the Session Recording Agent

For example, the following command installs the Session Recording Agent and creates a log file to capture the installation information.

**For 64-bit systems:**
msiexec /i SessionRecordingAgentx64.msi /q /l*v yourinstallationlog
SESSIONRECORDINGSERVERNAME=yourservername
SESSIONRECORDINGBROKERPROTOCOL=yourbrokerprotocol
SESSIONRECORDINGBROKERPORT=yourbrokerport

Note:
The SessionRecordingAgentx64.msi file is located on the Citrix Virtual Apps and Desktops ISO under \layout\image-full\x64\Session Recording.

For 32-bit systems:

msiexec /i SessionRecordingAgent.msi /q /l*v yourinstallationlog
SESSIONRECORDINGSERVERNAME=yourservername
SESSIONRECORDINGBROKERPROTOCOL=yourbrokerprotocol
SESSIONRECORDINGBROKERPORT=yourbrokerport

Note:
The SessionRecordingAgent.msi file is located on the Citrix Virtual Apps and Desktops ISO under \layout\image-full\x86\Session Recording.

Where:

- **yourservername** is the NetBIOS name or FQDN of the machine hosting the Session Recording Server. If not specified, this value defaults to **localhost**.
- **yourbrokerprotocol** is HTTP or HTTPS that Session Recording Agent uses to communicate with Session Recording Broker. If not specified, this value defaults to HTTPS.
- **yourbrokerport** is the port number that Session Recording Agent uses to communicate with Session Recording Broker. If not specified, this value defaults to zero, which directs Session Recording Agent to use the default port number for your selected protocol: 80 for HTTP or 443 for HTTPS.
- **/q** specifies quiet mode.
- **/l*v** specifies verbose logging.
- **yourinstallationlog** is the location of your installation log file.

### Install the Session Recording Player

Install the Session Recording Player on the Session Recording Server or on workstations in the domain.

**Step 1: Download the product software and launch the wizard**
Use a local administrator account to log on to the machine where you are installing the Session Recording Player component. Insert the DVD in the drive or mount the ISO file. If the installer does not launch automatically, double-click the **AutoSelect** application or the mounted drive.

The installation wizard launches.

**Step 2: Choose which product to install**

![Citrix Virtual Apps and Citrix Virtual Desktops selection](image)

Deliver applications and desktops to any user, anywhere, on any device.

- Hybrid cloud, cloud and enterprise provisioning
- Centralized and flexible management

Manage your delivery according to your needs:

- **Citrix Virtual Apps** Deliver applications
- **Citrix Virtual Desktops** Deliver applications and desktops

Click **Start** next to the product to install **Citrix Virtual Apps** or **Citrix Virtual Desktops**.

**Step 3: Select Session Recording**
Select the **Session Recording** entry.

**Step 4: Read and accept the license agreement**
On the **Software License Agreement** page, read the license agreement, accept it, and then click **Next**

**Step 5: Select the component to install and the installation location**
Select **Session Recording Player** and click **Next**.

**Step 6: Review the prerequisites and confirm the installation**
The **Summary** page shows your installation choices. You can click **Back** to return to the earlier wizard pages and make changes, or click **Install** to start the installation.

**Step 7: Complete the installation**
The Finish Installation page shows green check marks for all the prerequisites and components that have been installed and initialized successfully.

Click **Finish** to complete the installation of the Session Recording Player.

**Upgrade Session Recording**

You can upgrade certain deployments to later versions without having to first set up new machines or Sites. You can upgrade from the version of Session Recording included in the latest CU of XenApp and XenDesktop 7.6 LTSR, and from any later version, to the latest release of Session Recording.

**Note:**

When you upgrade Session Recording Administration from 7.6 to 7.13 or later and choose **Modify** in Session Recording Administration to add the Administrator Logging service, the SQL Server instance name does not appear on the **Administrator Logging Configuration** page. The following error message appears when you click **Next**: “Database connection test failed. Please enter correct Database instance name.” As a workaround, add the read permission for localhost users to the following SmartAuditor Server registry folder:
Requirements, preparation, and limitations

- Use the Session Recording installer’s graphical or command line interface to upgrade the Session Recording components on the machine where you installed the components.
- Before any upgrade activity, back up the database named CitrixSessionRecording in the SQL Server instance. In this way, you can restore it if any issues are discovered after the database upgrade.
- In addition to being a domain user, you must be a local administrator on the machines where you are upgrading the Session Recording components.
- If the Session Recording Server and Session Recording Database are not installed on the same server, you must have the database role permission to upgrade the Session Recording Database. Otherwise, you can:
  - Ask the database administrator to assign the securityadmin and dbcreator server role permissions for the upgrade. After the upgrade completes, the securityadmin and dbcreator server role permissions are no longer necessary and can be safely removed.
  - Or, use the SessionRecordingAdministrationx64.msi package to upgrade. During the msi upgrade, a dialog box prompts for the credentials of a database administrator who has the securityadmin and dbcreator server role permissions. Type the correct credentials and then click OK to continue the upgrade.
- If you do not plan to upgrade all the Session Recording Agents at the same time, Session Recording Agent 7.6.0 (or later) is compatible with the latest (current) release of Session Recording Server. However, some new features and bug fixes might not take effect.
- Any sessions started during the upgrade of Session Recording Server are not recorded.
- The Graphics Adjustment option in Session Recording Agent Properties is enabled by default after a fresh installation or upgrade to keep compatible with the Desktop Composition Redirection mode. You can disable this option manually after a fresh installation or upgrade.
- The Administrator Logging feature is not installed after you upgrade Session Recording from a previous release that doesn’t contain this feature. To add this new feature, modify the installation after the upgrade.
- If there are live recording sessions when the upgrade process starts, there is little chance that the recording can be complete.
- Review the following upgrade sequence, so that you can plan and mitigate potential outages.
Upgrade sequence

1. When the Session Recording Database and Session Recording Server are installed on different servers, stop the Session Recording Storage Manager service manually on the Session Recording Server. Then upgrade the Session Recording Database first.
2. Through the Internet Information Services (IIS) Manager, ensure that the Session Recording Broker is running. Upgrade the Session Recording Server. If the Session Recording Database and Session Recording Server are installed on the same server, the Session Recording Database is also upgraded.
3. The Session Recording service is back online automatically when the upgrade of the Session Recording Server is completed.
4. Upgrade the Session Recording Agent (on the master image).
5. Upgrade the Session Recording Policy Console with or after the Session Recording Server.
6. Upgrade the Session Recording Player.

Uninstall Session Recording

To remove the Session Recording components from a server or workstation, use the uninstall or remove programs option available from the Windows Control Panel. To remove the Session Recording Database, you must have the same securityadmin and dbcreator SQL Server role permissions as when you installed it.

For security reasons, the Administrator Logging Database is not removed after the components are uninstalled.

Dynamic session recording

January 29, 2020

Previously, session recording started strictly at the very beginning of sessions that met the recording policies and stopped strictly when those sessions ended.

Starting with the 7.18 release, Citrix introduces the dynamic session recording feature. With this feature, you can start or stop recording a specific session or sessions that a specific user launches, at any time during the sessions.

Note:

To make the feature work as expected, upgrade Session Recording, VDA and Delivery Controller to Version 7.18 or later.
Enable or disable dynamic session recording

On the Session Recording Agent, a registry value is added for enabling or disabling the feature. The registry value is set to 1 by default, which means that after installation or upgrade to 7.18, the feature is enabled by default.

To enable or disable the feature, do the following:

1. After the Session Recording installation is complete, log on as an administrator to the machine where you installed the Session Recording Agent.
2. Open the Registry Editor.
3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor.
4. Set the value of DynamicControlAllowed to 0 or use the default value, 1.
   - 1: enable dynamic recording
   - 0: disable dynamic recording
5. Restart the Session Recording Agent to make your setting take effect.

   If you are using MCS or PVS for deployment, change the setting on your master image and perform an update to make your change take effect.

   Warning:
   Incorrectly editing the registry can cause serious problems that might require you to reinstall your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the registry before you edit it.

Dynamically start or stop recording by using PowerShell commands in the Citrix Broker SDK

The following table lists three PowerShell commands added in the Citrix Broker SDK for the dynamic session recording feature. For information on the Citrix Broker SDK, see Citrix SDKs and APIs and Citrix Virtual Apps and Desktops SDK.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start-BrokerSessionRecording</td>
<td>Lets you start recording a specific active session, a list of active sessions launched by a specific user. For more information, run Get-Help Start-BrokerSessionRecording to see the command online help.</td>
</tr>
</tbody>
</table>
## Command Description

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop-BrokerSessionRecording</td>
<td>Lets you stop recording a specific active session, a list of active sessions, or sessions launched by a specific user. For more information, run <strong>Get-Help Stop-BrokerSessionRecording</strong> to see the command online help.</td>
</tr>
<tr>
<td>Get-BrokerSessionRecordingStatus</td>
<td>Lets you get the recording status of a specific active session. For more information, run <strong>Get-Help Get-BrokerSessionRecordingStatus</strong> to see the command online help.</td>
</tr>
</tbody>
</table>

For example, when a user reports an issue and needs timely support, you can use the feature to dynamically start recording the user’s active sessions, and play back the live recording to proceed with the follow-up troubleshooting. You can do the following:

1. Launch PowerShell from the Citrix Studio console.

   ![Citrix Studio console](image1)

2. Use the **Get-BrokerSession** command to get all active sessions of the target user.

   ![PowerShell session](image2)

© 1999-2020 Citrix Systems, Inc. All rights reserved.
3. Use the `Get-BrokerSessionRecordingStatus` command to get the recording status of the specified session.

```powershell
PS C:\Program Files\Citrix\Desktop Studio> Get-BrokerSessionRecordingStatus -Session 24
SessionNotRecorded
PS C:\Program Files\Citrix\Desktop Studio> Get-BrokerSessionRecordingStatus -Session 25
SessionNotRecorded
PS C:\Program Files\Citrix\Desktop Studio> _
```

**Note:**
The `-Session` parameter can accept only one sessionUid at a time.

4. Use the `Start-BrokerSessionRecording` command to start recording. By default, a notification message appears to inform users of the recording activity.

The following table shows common ways of using the `Start-BrokerSessionRecording` command.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start-BrokerSessionRecording -User DomainA\UserA</td>
<td>Starts recording all sessions of user UserA in the domain named DomainA and notifies UserA.</td>
</tr>
<tr>
<td>Start-BrokerSessionRecording -User DomainA\UserA-NotifyUser $false</td>
<td>Starts recording all sessions of user UserA in the domain named DomainA and does not notify UserA.</td>
</tr>
<tr>
<td>Start-BrokerSessionRecording -Sessions $SessionObject</td>
<td>Starts recording all sessions in the object named $SessionObject and notifies the user. To get the object $SessionObject, run $SessionObject=Get-BrokerSession -username UserA. The name of an object is prefixed with a dollar sign $. For more information, see Step 2 and the command online help.</td>
</tr>
<tr>
<td>Start-BrokerSessionRecording -Sessions uid1,uid2,...,uidn</td>
<td>Starts recording the sessions uid1, uid2, ..., and uidn, and notifies the users.</td>
</tr>
</tbody>
</table>

5. Use the `Get-BrokerSessionRecordingStatus` command to get the recording status of each target session. The status is supposed to be `SessionBeingRecorded`.

6. Play back the Live or Complete recordings in the Session Recording Player and proceed with the follow-up troubleshooting.
Note:
The last section of the timeline on the Player progress bar might show gray when you play back a “Complete” recording ended by the `Stop-BrokerSessionRecording` command and the last section of the recorded session is idle. It is not obvious when the recorded session has constant activities.

7. Use the `Stop-BrokerSessionRecording` command to stop recording when the reported issue has been triaged or resolved.

The following table shows common ways of using this command:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop-BrokerSessionRecording -User DomainA \ UserA</td>
<td>Stops recording all sessions of user UserA in the domain named DomainA.</td>
</tr>
<tr>
<td>Stop-BrokerSessionRecording -Sessions $SessionObject</td>
<td>Stops recording all sessions in the $SessionObject.</td>
</tr>
<tr>
<td>Stop-BrokerSessionRecording -Sessions uid1,uid2,...,uidn</td>
<td>Stops recording the sessions uid1, uid2, ..., and uidn.</td>
</tr>
</tbody>
</table>

On the Citrix Studio **Logging** screen, you can view the resulting logs of the `Start-BrokerSessionRecording` and `Stop-BrokerSessionRecording` commands.

Configure

August 10, 2018
After installing the Session Recording components, you can perform the following steps to configure Session Recording to record Citrix Virtual Apps and Desktops sessions and allow users to view them:

- Configure the connection to the Session Recording Server
- Authorize users
- Create and activate recording policies
- Specify where recordings are stored
- Specify file size for recordings
- Customize notification messages
- Enable or disable recording
- Enable or disable digital signing
- Administrator Logging
- Database high availability
- Load balancing
- Change your communication protocol
- Configure CEIP

Configure the connection to the Session Recording Server

September 4, 2019

Configure the connection of the Session Recording Player to the Session Recording Server

Before a Session Recording Player can play sessions, you must configure it to connect to the Session Recording Server that stores the recorded sessions. Each Session Recording Player can be configured with the ability to connect to multiple Session Recording Servers, but can connect to only one Session Recording Server at a time. If the Player is configured with the ability to connect to multiple Session Recording Servers, users can change which Session Recording Server the Player connects to by selecting a check box on the Connections tab at Tools > Options.

1. Log on to the workstation where the Session Recording Player is installed.
2. Start the Session Recording Player.
3. From the Session Recording Player menu bar, choose Tools > Options.
4. On the Connections tab, click Add.
5. In the Hostname field, type the name or IP address of the machine hosting the Session Recording Server and select the protocol. By default, Session Recording is configured to use HTTP-S/SSL to secure communications. If SSL is not configured, select HTTP.
6. To configure the Session Recording Player with the ability to connect to multiple Session Recording Servers, repeat Steps 4 and 5 for each Session Recording Server.
7. Ensure that you select the check box for the Session Recording Server you want to connect to.

**Configure the connection of the Session Recording Agent to the Session Recording Server**

The connection between the Session Recording Agent and the Session Recording Server is typically configured when the Session Recording Agent is installed. To configure this connection after the Session Recording Agent is installed, use Session Recording Agent Properties.

1. Log on to the server where the Session Recording Agent is installed.
2. From the **Start** menu, choose **Session Recording Agent Properties**.
3. Click the **Connections** tab.
4. In the **Session Recording Server** field, type the FQDN of the Session Recording Server.
   
   **Note:**
   
   To use Message Queuing over HTTPS (TCP is used by default), type an FQDN in the **Session Recording Server** field. Otherwise, session recording fails.
5. In the **Session Recording Storage Manager message queue** section, select the protocol that is used by the Session Recording Storage Manager to communicate and change the default port number if necessary.
6. In the **Message life** field, accept the default 7,200 seconds (two hours) or type a new value for the number of seconds each message is retained in the queue if there is a communication failure. After this time elapses, the message is deleted and the file is playable until the point where the data is lost.
7. In the **Session Recording Broker** section, select the communication protocol that the Session Recording Broker uses to communicate and change the default port number if necessary.
8. When prompted, restart the **Session Recording Agent Service** to accept the changes.

**Authorize users**

May 7, 2019

To grant users the rights, you assign users to roles using the Session Recording Authorization Console on the Session Recording Server. Five roles are available:
Important:
For security reasons, grant users only the rights they need to perform specific functions, such as viewing recorded sessions.

- **PolicyAdministrator.** Grants the right to view, create, edit, delete, and enable recording policies. By default, administrators of the machine hosting the Session Recording Server are members of this role.

- **PolicyQuery.** Allows the servers hosting the Session Recording Agent to request recording policy evaluations. By default, authenticated users are members of this role.

- **LoggingWriter.** Grants the right to write the Administrator Logging logs. By default, local administrators and the Network Service group are members of this role. Changing the default **LoggingWriter** membership can cause log writing failure.

- **LoggingReader.** Grants the right to query the Administrator Logging logs. There is no default membership in this role.

- **Player.** Grants the right to view recorded Citrix Virtual Apps and Desktops sessions. There is no default membership in this role. When you install Session Recording, no user has the right to play recorded sessions. You must assign the right to each user, including the administrator. A user without the permission to play recorded sessions receives the following error message when trying to play a recorded session:

```
Search Failed

Search for recorded session files failed.
Access to Session Recording Server was denied. Rejected user request as access is denied by role-based security.
```

To assign users to a role, do the following:

1. Log on as an administrator to the machine hosting the Session Recording Server.
2. Start the Session Recording Authorization Console.
3. Select the role to which you want to assign users.
4. From the menu bar, choose **Action > Assign Users and Groups.**
5. Add the users and groups.

Session Recording supports users and groups defined in Active Directory.

Any changes made to the console take effect during the update that occurs once every minute. Ad-
Additionally, starting with the 1906 release, you can use the Session Recording Policy Console to create recording viewing policies. For more information, see Recording viewing policies.

Configure policies

December 18, 2019

Use the Session Recording Policy Console to create recording policies, event logging policies, and recording viewing policies. When creating the policies, you can specify Delivery Controllers from both the Citrix Cloud and on-premises environments.

Important:

To use the Session Recording Policy Console, you must have the Broker PowerShell Snap-in (Broker_PowerShellSnapIn_x64.msi) or the Citrix Virtual Apps and Desktops Remote PowerShell SDK (CitrixPoshSdk.exe) installed. The installer does not install the snap-ins automatically. Locate the Broker PowerShell snap-in on the Citrix Virtual Apps and Desktops ISO (\layout\image-full\x64\Citrix Desktop Delivery Controller); locate the Citrix Virtual Apps and Desktops Remote PowerShell (PS) SDK on the Citrix web site. Follow the instructions for installing the snap-in and the SDK manually. Failure to comply can cause an error.

Recording policies

You can activate system-defined recording policies available when Session Recording is installed or create and activate your own custom recording policies. System-defined recording apply a single rule to all users, published applications, and servers. Custom recording policies specifying which users, published applications, and servers are recorded.

The active recording policy determines which sessions are recorded. Only one recording policy is active at a time.

System-defined recording policies

Session Recording provides the following system-defined recording policies:

- **Do not record.** The default policy. If you do not specify another policy, no sessions are recorded.
- **Record everyone with notification.** If you choose this policy, all sessions are recorded. A pop-up window appears to notify recording occurrence.
- **Record everyone without notification.** If you choose this policy, all sessions are recorded. No pop-up window appears to notify recording occurrence.
You cannot modify or delete the system-defined recording policies.

Create a custom recording policy

When you create your own recording policy, you make rules to specify which users or groups, published applications or desktops, delivery groups or VDA machines, and Citrix Workspace app client IP addresses have their sessions recorded. A wizard within the Session Recording Policy Console helps you create rules. To obtain the list of published applications or desktops and the list of delivery groups or VDA machines, you must have the read permission as a Site administrator. Configure the administrator read permission on the Delivery Controller of the Site.

For each rule you create, you specify a recording action and rule criteria. The recording action applies to sessions that meet the rule criteria.

For each rule, choose one recording action:

- **Do not record.** (Choose Disable session recording in the Rules wizard.) This recording action specifies that sessions meeting the rule criteria are not recorded.
- **Record with notification.** (Choose Enable session recording with notification in the Rules wizard.) This recording action specifies that sessions meeting the rule criteria are recorded. A pop-up window appears to notify recording occurrence.
- **Record without notification.** (Choose Enable session recording without notification in the Rules wizard.) This recording action specifies that sessions meeting the rule criteria are recorded. Users are unaware that they are being recorded.

For each rule, choose at least one of the following items to create the rule criteria:

- **Users or Groups.** Creates a list of users or groups to which the action of the rule applies. Session Recording allows you to use Active Directory groups and white list users.
- **Published Applications or Desktop.** Creates a list of published applications or desktops to which the action of the rule applies. In the Rules wizard, choose the Citrix Virtual Apps and Desktops Site or Sites on which the applications or desktops are available.
- **Delivery Groups or Machines.** Creates a list of Delivery Groups or machines to which the action of the rule applies. In the Rules wizard, choose the location of the Delivery Groups or machines.
- **IP Address or IP Range.** Creates a list of IP addresses or ranges of IP addresses to which the action of the rule applies. On the Select IP Address and IP Range screen, add a valid IP address or IP range for which recording is enabled or disabled. The IP addresses mentioned here are the IP addresses of the Citrix Workspace apps.

Note:
The Session Recording Policy Console supports configuring multiple criteria within a single rule. When a rule applies, both the “AND” and the “OR” logical operators are used to compute the
final action. Generally speaking, the “OR” operator is used between items within a criterion, and the “AND” operator is used between separate criteria. If the result is true, the Session Recording policy engine takes the rule’s action. Otherwise, it goes to the next rule and repeats the process.

When you create more than one rule in a recording policy, some sessions might match the criteria for more than one rule. In these cases, the rule with the highest priority is applied to the sessions.

The recording action of a rule determines its priority:

- Rules with the Do not record action have the highest priority
- Rules with the Record with notification action have the next highest priority
- Rules with the Record without notification action have the lowest priority

Some sessions might not meet any rule criteria in a recording policy. For these sessions, the action of the policy fallback rule applies. The action of the fallback rule is always Do not record. You cannot modify or delete the fallback rule.

To create a custom recording policy:

1. Log on as an authorized Policy Administrator to the server where the Session Recording Policy Console is installed.
2. Start the Session Recording Policy Console and select Recording Policies in the left pane. From the menu bar, choose Add New Policy.
3. Right-click the New policy and select Add Rule.
4. Select a recording option - In the Rules wizard, select Disable session recording, Enable Session Recording with notification (or without notification), and then click Next.
5. Select the rule criteria - You can choose one or more rule criteria:
   Users or Groups
   Published Applications or Desktop
   Delivery Groups or Machines
   IP Address or IP Range
6. Edit the rule criteria - To edit, click the underlined values. The values are underlined based on the criteria you chose in the previous step.

   Note:
   If you choose the Published Applications or Desktop underlined value, the Site Address is the IP address, a URL, or a machine name if the Controller is on a local network. The Name of Application list shows the display name.

   When choosing Published Applications or Desktop or Delivery Groups or Machines, specify the Delivery Controller for your Session Recording Policy Console to communicate with.

   The Session Recording Policy Console is the only channel to communicate with Delivery Controllers from the Citrix Cloud and on-premises environments.
For example, when choosing **Delivery Groups or Machines**, click the corresponding hyperlink in Step 3 of the preceding screenshot and click **Add** to add queries to the Controller.
For a description of use cases that cover the on-premises and the Citrix Cloud Delivery Controllers, see the following table:

<table>
<thead>
<tr>
<th>Use Case</th>
<th>Action Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-Premises Delivery Controller</td>
<td>1. Install Broker_PowerShellSnapIn_x64.msi. 2. Clear the <strong>Citrix Cloud Controller</strong> check box.</td>
</tr>
<tr>
<td>Citrix Cloud Delivery Controller</td>
<td>1. Install the Citrix Virtual Apps and Desktops Remote PowerShell SDK. 2. Validate the Citrix Cloud account credentials. 3. Select the <strong>Citrix Cloud Controller</strong> check box.</td>
</tr>
<tr>
<td>Switch from an on-premises Delivery Controller to a Citrix Cloud Delivery Controller</td>
<td>1. Uninstall Broker_PowerShellSnapIn_x64.msi and restart the machine. 2. Install the Citrix Virtual Apps and Desktops Remote PowerShell SDK. 3. Validate the Citrix Cloud account credentials. 4. Select the <strong>Citrix Cloud Controller</strong> check box.</td>
</tr>
<tr>
<td>Use Case</td>
<td>Action Required</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Switch from a Citrix Cloud Delivery Controller to an on-premises Delivery Controller</td>
<td>1. Uninstall the Citrix Virtual Apps and Desktops Remote PowerShell SDK and restart the machine. 2. Install Broker_PowerShellSnapIn_x64.msi. 3. Clear the <strong>Citrix Cloud Controller</strong> check box.</td>
</tr>
</tbody>
</table>

Validating the Citrix Cloud credentials

To query Delivery Controllers hosted in the Citrix Cloud, manually validate your Citrix Cloud credentials on the machine where the Session Recording Policy Console is installed. Failure to comply can cause an error and your Session Recording Policy Console might not work as expected.

To do the manual validation:

a) Log on to the Citrix Cloud console and locate **Identity and Access Management > API Access**. Create an API access Secure Client for obtaining an authentication profile that can bypass the Citrix Cloud authentication prompts. Download your Secure Client, rename and save it in a safe location. The file name is defaulted to secureclient.csv.

![Citrix Cloud Console](image)

b) Open a PowerShell session and run the following command to have the authentication profile (obtained in the preceding step) take effect.

```
1. asnp citrix.*
2. Set-XDCredentials -CustomerId "citrixdemo" -SecureClientFile "c:\temp\secureclient.csv" -ProfileType CloudAPI -StoreAs "default"
```

Set **CustomerId** and **SecureClientFile** as required. The preceding command creates a default authentication profile for customer “citrixdemo” to bypass authentication prompts in the current and all subsequent PowerShell sessions.

7. Follow the wizard to finish the configuration.
**Note:** Limitation regarding prelaunched application sessions:

- If the active policy tries to match an application name, the applications launched in the prelaunched session are not matched, which results in the session not being recorded.
- If the active policy records every application, when a user logs on to Citrix Workspace app for Windows (at the same time that a prelaunched session is established), a recording notification appears and the prelaunched (empty) session and any applications to be launched in that session going forward are recorded.

As a workaround, publish applications in separate Delivery Groups according to their recording policies. Do not use an application name as a recording condition. This ensures that prelaunched sessions can be recorded. However, notifications still appear.

**Use Active Directory groups**

Session Recording allows you to use Active Directory groups when creating policies. Using Active Directory groups instead of individual users simplifies creation and management of rules and policies. For example, if users in your company’s finance department are contained in an Active Directory group named Finance, you can create a rule that applies to all members of this group by selecting the Finance group in the Rules wizard when creating the rule.

**White list users**

You can create Session Recording policies ensuring that the sessions of some users in your organization are never recorded. This case is called *white listing* these users. White listing is useful for users who handle privacy-related information or when your organization does not want to record the sessions of a certain class of employees.

For example, if all managers in your company are members of an Active Directory group named Executive, you can ensure that sessions of these users are never recorded by creating a rule that disables session recording for the Executive group. While the policy containing this rule is active, no sessions of members of the Executive group are recorded. The sessions of other members of your organization are sessions recorded based on other rules in the active policy.

**Configure Director to use the Session Recording Server**

You can use the Director console to create and activate the recording policies.

1. For an HTTPS connection, install the certificate to trust the Session Recording Server in the Trusted Root Certificates of the Director server.
2. To configure the Director server to use the Session Recording Server, run the `C:\inetpub\wwwroot\Director\tools\DirectorConfig.exe /configsessionrecording` command.

3. Type the IP address or FQDN of the Session Recording Server and the port number and connection type (HTTP/HTTPS) that the Session Recording Agent uses to connect to the Session Recording Broker on the Director server.

**Event logging policies**

Session Recording supports centralized configuration of event logging policies. You can create policies in the Session Recording Policy Console to log various events.

**Note:**

To log the insertion of USB mass storage devices and the application starts and ends, upgrade the Session Recording Administration components (Session Recording Database, Session Recording Server, and Session Recording Policy Console) and the Session Recording Agent to Version 1811 or later.

To log file operation events and web browsing activities, upgrade the Session Recording Administration components (Session Recording Database, Session Recording Server, and Session Recording Policy Console) and the Session Recording Agent to Version 1903 or later.

**System-defined event logging policy**

The system-defined event logging policy is **Do not log**. It is inactive by default. When it is active, no events are logged.

You cannot modify or delete the system-defined event logging policy.

**Create a custom event logging policy**

When you create your own event logging policy, you make rules to specify which users or groups, published applications or desktops, delivery groups or VDA machines, and Citrix Workspace app client IP addresses have specific events logged during session recording. A wizard within the Session Recording Policy Console helps you create rules. To obtain the list of published applications or desktops and the list of delivery groups or VDA machines, you must have the read permission as a Site administrator. Configure the administrator read permission on the Delivery Controller of the Site.

To create a custom event logging policy:

1. Log on as an authorized Policy Administrator to the server where the Session Recording Policy Console is installed.
2. Start the Session Recording Policy Console.
   By default, there is no active event logging policy.

3. Select **Event Logging Policies** in the left pane. From the menu bar, choose **Add New Policy** to create an event logging policy.

4. (Optional) Right-click the new event logging policy and rename it.

5. Right-click the new event logging policy and select **Add Rule**.
   a) Specify one or more target events to monitor by selecting the check box next to each event type.
• **Log CDM mapped USB events**: Logs the insertion of a Client Drive Mapping (CDM) mapped mass storage device in a client device where Citrix Workspace app for Windows or for Mac is installed, and tags the event in the recording.

• **Log generic redirected USB events**: Logs the insertion of a generic redirected mass storage device in a client device where Citrix Workspace app for Windows or for Mac is installed, and tags the event in the recording.

• **Log app start events**: Logs the starts of target applications and tags the event in the recording.

• **Log app end events**: Logs the ends of target applications and tags the event in the recording.

  **Note:**
  Session Recording cannot log the end of an application without logging its start. Therefore, in the Rules wizard, the Log app end events check box is grayed out before you select Log app start events.

• **App monitoring list**: When you select Log app start events and Log app end events, use the App monitoring list to specify target applications to monitor and to avoid
excessive amount of events from flooding the recordings. No application is specified by default, which means no application is captured by default.

**Note:**

- To capture the start and end of an application, add the process name of the application in the **App monitoring list**. For example, to capture the start of Remote Desktop Connection, add the process name mstsc.exe in the **App monitoring list**. When you add a process to the **App monitoring list**, applications driven by the added process and its child processes are all monitored.
- Separate process names with a semicolon (;).
- Only exact match is supported. Wildcards are not supported.
- Process names you add are case-insensitive.
- To avoid excessive amount of events from flooding the recordings, do not add any system process names (for example, explorer.exe) and web browsers in the registry.

  • **Log file operation events**: Logs the operations on target files in the recording.

  • **File monitoring list**: When you select **Log sensitive file events**, use the **File monitoring list** to specify target files to monitor. You can specify folders to capture all files within them. No file is specified by default, which means no file is captured by default.

  **Note:**

  - To capture renaming, creation, deletion, or moving operations on a file, add the path string of the file folder (not the file name or the root path of the file folder) in the **File monitoring list**. For example, to capture renaming, creation, deletion, and moving operations on the sharing.ppt file in C:\User\File, add the path string C:\User\File in the **File monitoring list**.
  - Both local file paths and remote shared folder paths are supported. For example, to capture operations on the RemoteDocument.txt file in the \remote.address\Documents folder, add the path string \remote.address\Documents in the **File monitoring list**.
  - Separate monitored paths with a semicolon (;).
  - Only exact matches are supported. Wildcards are not supported.
  - Path strings are case-insensitive.

**Limitations:**

- Copying files or folders from a monitored folder to an unmonitored folder cannot be captured.
- When the length of a file or folder path including the file or folder name exceeds the maximum length (260 characters), operations on the file or folder cannot be captured.
- Pay attention to the database size. To prevent large numbers of events from being captured, back up or delete the “Event” table regularly.
- When large numbers of events are captured at time intervals, the Player displays and the database stores only one event item for each event type to avoid storage expansion.

• **Log web browsing activities**: Logs user activities on supported browsers and tags the browser name, URL, and page title in the recording.

<table>
<thead>
<tr>
<th>Events and Bookmarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>5:42:32 AM  Web browsing: <a href="https://www.google.com">https://www.google.com</a>, Google · Google Chrome · chrome</td>
</tr>
</tbody>
</table>

List of supported browsers:

<table>
<thead>
<tr>
<th>Browser</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chrome</td>
<td>69 and later</td>
</tr>
<tr>
<td>Internet Explorer</td>
<td>11</td>
</tr>
<tr>
<td>Firefox</td>
<td>61 and later</td>
</tr>
</tbody>
</table>

• **Log top-most window activities**: Logs top-most window activities and tags the process name, title, and process number in the recording.

<table>
<thead>
<tr>
<th>Events and Bookmarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:56:08 AM  Top-most window: EXCEL, Book2, 5880</td>
</tr>
<tr>
<td>1:56:22 AM  Top-most window: explorer, CITRIXINSTALLATIONLOGS, 7212</td>
</tr>
<tr>
<td>1:56:36 AM  Top-most window: Taskmgr, CdIsvc.exe, 9276</td>
</tr>
<tr>
<td>1:56:39 AM  Top-most window: explorer, Application, 7212</td>
</tr>
<tr>
<td>1:56:55 AM  Top-most window: notepad++, 4940</td>
</tr>
<tr>
<td>1:56:59 AM  Top-most window: explorer, Desktop, 7212</td>
</tr>
<tr>
<td>1:57:00 AM  Top-most window: WINWORD, Bixelsb q.docx, 0036</td>
</tr>
<tr>
<td>1:57:13 AM  Top-most window: notepad++, 4940</td>
</tr>
<tr>
<td>1:57:20 AM  Top-most window: Taskmgr, CdIsvc.exe, 9276</td>
</tr>
<tr>
<td>1:57:34 AM  Top-most window: Taskmgr, CitrixAuthentication, VirtualSmartcard.exe, 9276</td>
</tr>
<tr>
<td>1:57:51 AM  Top-most window: regedit, FileOperationMonitorList, 6984</td>
</tr>
<tr>
<td>1:58:04 AM  Top-most window: notepad++, shi, 4940</td>
</tr>
<tr>
<td>1:58:25 AM  Top-most window: explorer, Task Switcher, 7212</td>
</tr>
<tr>
<td>1:58:29 AM  Top-most window: EXCEL, Grid, 6680</td>
</tr>
</tbody>
</table>

b) Select and edit the rule criteria.

Similar to creating a custom recording policy, you can choose one or more rule criteria: **Users or Groups, Published Applications or Desktop, Delivery Groups or Machines**, and
**IP Address or IP Range.** For more information, see the instructions in the Create a custom recording policy section.

**Note:**
Some sessions might not meet any rule criteria in an event logging policy. For these sessions, the event logging action of the fallback rule applies, which is always **Do not log**. You cannot modify or delete the fallback rule.

c) Follow the wizard to complete the configuration.

---

**Compatibility with registry configurations**

When Session Recording is newly installed or upgraded, no active event logging policy is available by default. At this time, each Session Recording Agent respects the registry values under HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SessionEvents to determine whether to log specific events. For a description of the registry values, see the following table:
<table>
<thead>
<tr>
<th>Registry Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EnableSessionEvents</td>
<td>1: enables event logging globally; 0: disables event logging globally (default value data).</td>
</tr>
<tr>
<td>EnableCDMUSBDriveEvents</td>
<td>1: enables logging the insertion of CDM mapped USB mass storage devices; 0: disables logging the insertion of CDM mapped USB mass storage devices (default value data).</td>
</tr>
<tr>
<td>EnableGenericUSBDriveEvents</td>
<td>1: enables logging the insertion of generic redirected USB mass storage devices; 0: disables logging the insertion of generic redirected USB mass storage devices (default value data).</td>
</tr>
<tr>
<td>EnableAppLaunchEvents</td>
<td>1: enables logging only application starts; 2: enables logging both application starts and ends; 0: disables logging application starts and ends (default value data).</td>
</tr>
<tr>
<td>AppMonitorList</td>
<td>Specifies target applications to monitor. No application is specified by default, which means no application is captured by default.</td>
</tr>
<tr>
<td>EnableFileOperationMonitorEvents</td>
<td>1: enables logging file operations; 0: disables logging file operations (default value data).</td>
</tr>
<tr>
<td>FileOperationMonitorList</td>
<td>Specifies target folders to monitor. No folder is specified by default, which means no file operation is captured by default.</td>
</tr>
<tr>
<td>EnableWebBrowsingActivities</td>
<td>1: enables logging web browsing activities; 0: disables logging web browsing activities (default value data).</td>
</tr>
</tbody>
</table>

Here are some compatible scenarios:

- Session Recording 1912 is newly installed or upgraded from a previous release (earlier than 1811) that does not support event logging, the related registry values on each Session Recording Agent are the default. Because there is no active event logging policy by default, no events are logged.

- If Session Recording 1912 is upgraded from a previous release (earlier than 1811) that supports event logging but has the feature disabled before your upgrade, the related registry values on each Session Recording Agent remain the default. Because there is no active event logging policy by default, no events are logged.
• If Session Recording 1912 is upgraded from a previous release (earlier than 1811) that supports event logging and has the feature partially or fully enabled before your upgrade, the related registry values on each Session Recording Agent remain the same. Because there is no active event logging policy by default, the event logging behavior remains the same.

• If Session Recording 1912 is upgraded from 1811, the event logging policies configured in the Policy Console remain in use.

Caution:
When you activate the system-defined or a custom event logging policy in the Session Recording Policy Console, the relevant registry settings on each Session Recording Agent are ignored and you cannot use registry settings for event logging any longer.

Recording viewing policies

The Session Recording Player supports role-based access control. You can create recording viewing policies in the Session Recording Policy Console and add multiple rules to each policy. Each rule determines which user or user group can view the recordings originating from other users and user groups, published applications and desktops, and delivery groups and VDAs you specify.

Create a custom recording viewing policy

Before you can create recording viewing policies, enable the feature as follows:

1. Log on to the machine hosting the Session Recording Server.
2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the RBAC tab.
4. Select the Allow to configure recording viewing policies check box.
To create a custom recording viewing policy:

**Note:** Different from recording policies and event logging policies, a recording viewing policy (including all rules added within) is active immediately when it is created. You do not have to activate it.

1. Log on as an authorized Policy Administrator to the server where the Session Recording Policy Console is installed.
2. Start the Session Recording Policy Console. By default, there is no recording viewing policy.
Note: The Recording Viewing Policies menu is not available unless you have enabled the feature in Session Recording Server Properties.

3. Select Recording Viewing Policies in the left pane. From the menu bar, choose Add New Policy to create a recording viewing policy.

4. (Optional) Right-click the new policy and rename it.
5. Right-click the new policy and select **Add rule**.

   a) Specify which user or user group can view the recordings originating from other users and user groups you specify.
Note:

In each rule, you can select only one user or user group as the recording viewer. If you select multiple users or user groups, only your most recent selection takes effect and appears in the text box. When you specify a recording viewer, ensure that you have assigned the viewer to the Player role. A user without the permission to play recorded sessions receives an error message when trying to play a recorded session. For more information, see Authorize users.

b) Select and edit the rule criteria to specify whose recordings can be viewed by the viewer specified earlier:

- Users or Groups
- Published Applications or Desktop
- Delivery Groups or Machines
**Note:** If you leave the rule criteria unspecified, the viewer specified earlier has no recordings to view.

c) Follow the wizard to complete the configuration.
Activate a policy

1. Log on as an administrator to the machine where you installed the Session Recording Policy Console.
2. Start the Session Recording Policy Console.
3. If the Connect to Session Recording Server window appears, ensure that the name of the Session Recording Server, protocol, and port are correct. Click OK.
4. In the Session Recording Policy Console, expand Recording Policies or Event Logging Policies as required.
5. Select the policy to activate.
6. From the menu bar, choose Activate Policy.

Modify a policy

1. Log on as an administrator to the machine where you installed the Session Recording Policy Console.
2. Start the Session Recording Policy Console.
3. If the Connect to Session Recording Server window appears, ensure that the name of the Session Recording Server, protocol, and port are correct. Click OK.
4. In the Session Recording Policy Console, expand Recording Policies or Event Logging Policies as required.
5. Select the policy you want to modify. The rules for the policy appear in the right pane.
6. To add, modify, or delete a rule:
   - From the menu bar, choose Add New Rule. If the policy is active, a pop-up window appears requesting confirmation of the action. Use the Rules wizard to create a rule.
   - Select the rule you want to modify, right-click, and choose Properties. Use the Rules wizard to modify the rule.
   - Select the rule you want to delete, right-click, and choose Delete Rule.

Delete a policy

Note:
You cannot delete a system-defined policy or a policy that is active.

1. Log on as an administrator to the machine where you installed the Session Recording Policy Console.
2. Start the Session Recording Policy Console.
3. If the Connect to Session Recording Server window appears, ensure that the name of the Session Recording Server, protocol, and port are correct. Click OK.
4. In the Session Recording Policy Console, expand Recording Policies or Event Logging Policies as required.
5. In the left pane, select the policy to delete. If the policy is active, you must activate another policy.
6. From the menu bar, choose Delete Policy.
7. Select Yes to confirm the action.

Understand rollover behavior

When you activate a policy, the previously active policy remains in effect until the session being recorded ends or the session recording file rolls over. Files roll over when they have reached the maximum size. For more information about the maximum file size for recordings, see Specify file size for recordings.

The following table details what happens when you apply a new recording policy while a session is being recorded and a rollover occurs:
Session Recording 2003

<table>
<thead>
<tr>
<th>If the previous recording policy was:</th>
<th>And the new recording policy is:</th>
<th>After a rollover, the recording policy will be:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not record</td>
<td>Any other policy</td>
<td>No change. The new policy takes effect only when the user logs on to a new session.</td>
</tr>
<tr>
<td>Record without notification</td>
<td>Do not record</td>
<td>Recording stops.</td>
</tr>
<tr>
<td>Record without notification</td>
<td>Record with notification</td>
<td>Recording continues and a notification message appears.</td>
</tr>
<tr>
<td>Record with notification</td>
<td>Do not record</td>
<td>Recording stops.</td>
</tr>
<tr>
<td>Record with notification</td>
<td>Record without notification</td>
<td>Recording continues. No message appears the next time a user logs on.</td>
</tr>
</tbody>
</table>

Specify where recordings are stored

November 9, 2018

Use Session Recording Server Properties to specify where recordings are stored and where archived recordings are restored for playback.

**Note:**

To archive files or restore deleted files, use the ICLDB command.

Specify directories for storing recordings

By default, recordings are stored in the drive:`\SessionRecordings` directory of the machine hosting the Session Recording Server. You can change the directory where the recordings are stored, add extra directories to load-balance across multiple volumes, or make use of additional space. Multiple directories in the list indicate that recordings are load-balanced across the directories. You can add a directory multiple times. Load balancing cycles through the directories.

1. Log on to the machine hosting the Session Recording Server.
2. From the **Start** menu, choose **Session Recording Server Properties**.
3. In **Session Recording Server Properties**, click the **Storage** tab.
4. Use the **File storage directories** list to manage the directories where recordings are stored.

After you select the directories, Session Recording grants its service with Full Control permission to these directories.
You can create file storage directories on the local drive, the SAN volume, or a location specified by a UNC network path. Network mapped drive letters are not supported. Do not use Session Recording with NAS. Serious performance and security problems can occur when recording data is written to a network drive.

Specify a directory for restoring archived recordings for playback

By default, archived recordings are restored in the drive:\SessionRecordingsRestore directory of the computer hosting the Session Recording Server. You can change the directory.

1. Log on to the computer hosting the Session Recording Server.
2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Storage tab.
4. In the Restore directory for archived files field, type your directory for restoring archived recordings.

Specify file size for recordings

November 9, 2018

As recordings grow in size, the files can take longer to download and react more slowly when you use the seek slider to navigate during playback. To control file size, specify a threshold limit for a file. When the recording reaches this limit, Session Recording closes the file and opens a new one to continue recording. This action is called a rollover.

You can specify two thresholds for a rollover:

- **File size.** When the file reaches the specified number of MB, Session Recording closes the file and opens a new one. By default, files roll over after reaching 50 MB. You can specify a limit from 10 MB to 1 GB.

- **Duration.** After the session records for the specified number of hours, the file is closed and a new file is opened. By default, files roll over after recording for 12 hours. You can specify a limit from one to 24 hours.

Session Recording checks both fields to determine which event occurs first to determine when to roll over. For example, if you specify 17 MB for the file size and six hours for the duration and the recording reaches 17 MB in three hours, Session Recording reacts to the 17 MB file size to close the file and open a new one.

To prevent the creation of many small files, Session Recording does not roll over until at least one hour elapses (this is the minimum number that you can type) regardless of the value specified for the file size. The exception to this rule is if the file size surpasses 1 GB.
Specify the maximum file size for recordings

1. Log on to the machine hosting the Session Recording Server.
2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Rollover tab.
4. Type an integer between 10 and 1,024 to specify the maximum file size in MB.
5. Type an integer between 1 and 24 to specify the maximum recording duration in hours.

Customize notification messages

October 25, 2019

If the active recording policy specifies that users are notified when their sessions are recorded, a pop-up window appears, displaying a notification message after the users type their credentials. The default notification message is “Your activity with the desktop or program(s) you recently started is being recorded. If you object to this condition, close the desktop or program(s).” The users can click OK to dismiss the window and continue their sessions.

The default notification message appears in the language of the operating system of the computers hosting the Session Recording Server.

You can create custom notifications in languages you choose. However, you can have only one notification message for each language. Your users see notification messages in the languages of their preferred local settings.

Create a notification message

1. Log on to the machine hosting the Session Recording Server.
2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Notifications tab.
4. Click Add.
5. Choose the language for the message and type the new message. You can create only one message for each language.

After accepting and activating, the new message appears in the language-specific notification message box.
Enable or disable recording

November 27, 2019

You install the Session Recording Agent on multi-session OS VDAs for which you want to record sessions. Within each Agent is a setting that enables recording for the VDA on which it is installed. After recording is enabled, Session Recording evaluates the active recording policy that determines which sessions are recorded.

When you install the Session Recording Agent, recording is enabled. Citrix recommends that you disable Session Recording on VDAs that are not recorded because they experience a small impact on performance, even if no recording takes place.

Enable or disable recording on a VDA

1. Log on to the server where the Session Recording Agent is installed.
2. From the Start menu, choose Session Recording Agent Properties.
3. Under Session Recording, select or clear the Enable session recording for this VDA machine check box to specify whether sessions can be recorded for this VDA.
4. When prompted, restart the Session Recording Agent Service to accept the change.

Note:

When you install Session Recording, the active policy is Do not record (no sessions are recorded on any server). To begin recording, use the Session Recording Policy Console to activate a different policy.

Enable custom event recording

Session Recording allows you to use third-party applications to insert custom data, known as events, to recorded sessions. These events appear when the session is viewed using the Session Recording Player. They are part of the recorded session file and cannot be modified after the session is recorded.

For example, an event might contain the following text: “User opened a browser.” Each time a user opens a browser during a session that is being recorded, the text is inserted to the recording at that point. When the session is played using the Session Recording Player, the viewer can locate and count the times that the user opened a browser by noting the number of markers that appear in the Events and Bookmarks list in the Session Recording Player.

To insert custom events to recordings on a server:
• Use **Session Recording Agent Properties** to enable a setting on each server where you want to insert custom events. You must enable each server separately. You cannot globally enable all servers in a site.

• Write applications built on the Event API that runs within each user’s Citrix Virtual Apps and Desktops session (to inject the data into the recording).

The Session Recording installation includes an event recording COM application (API) that allows you to insert text from third-party applications to a recording. You can use the API from many programming languages including Visual Basic, C++, or C#. For more information, see the Knowledge Center article **CTX226844**. The Session Recording Event API .dll is installed as part of the Session Recording installation. You can find it at C:\Program Files\Citrix\SessionRecording\Agent\Bin\Interop.UserApi.dll.

To enable custom event recording on a server, do the following:

1. Log on to the server where the Session Recording Agent is installed.
2. From the **Start** menu, choose **Session Recording Agent Properties**.
3. In **Session Recording Agent Properties**, click the **Recording** tab.
4. Under **Custom event recording**, select the **Allow third party applications to record custom data on this server** check box.

### Enable or disable digital signing

**June 27, 2019**

If you install certificates on the machines where you installed the Session Recording Server and the Session Recording Player, you can enhance the security of your Session Recording deployment by assigning digital signatures to Session Recording.

By default, digital signing is disabled. After you select the certificate to sign the recordings, Session Recording grants the read permission to the Session Recording Storage Manager Service.

### Enable digital signing

1. Log on to the machine hosting the Session Recording Server.
2. From the **Start** menu, choose **Session Recording Server Properties**.
3. In **Session Recording Server Properties**, click the **Signing** tab.
4. Browse to the certificate that enables secure communication among the computers on which the Session Recording components are installed.
Disable digital signing

1. Log on to the machine hosting the Session Recording Server.
2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Signing tab.
4. Click Clear.

Administrator Logging

November 9, 2018

Session Recording Administrator Logging logs the following activities:

- Changes to recording policies and event logging policies on the Session Recording Policy Console or Citrix Director.
- Changes in Session Recording Server Properties.
- Downloads of recordings in the Session Recording Player.
- Recording a session by Session Recording after policy query.
- Unauthorized attempts to access the Administrator Logging service.

Warning:

Editing the registry incorrectly can cause serious problems that might require you to reinstall your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the registry before you edit it.

Disable or enable Administrator Logging

After installation, you can disable or enable the Session Recording Administrator Logging feature in Session Recording Server Properties.

1. As an administrator, log on to the machine where Session Recording Administrator Logging is installed.
2. From the Start menu, choose Session Recording Server Properties.
3. Click the Logging tab.

When Session Recording Administrator Logging is disabled, no new activities are logged. You can query the existing logs from the web-based UI.
When **mandatory blocking** is enabled, the following activities are blocked if the logging fails. A system event is also logged with an Event ID 6001:

- Changes to recording policies on the Session Recording Policy Console or Citrix Director.
- Changes in Session Recording Server Properties.

The recording of sessions is not impacted by the mandatory blocking setting.

**Configure an Administrator Logging service account**

By default, Administrator Logging is running as a web application in Internet Information Services (IIS), and its identity is Network Service. To enhance the security level, you can change the identity of this web application to a service account or a specific domain account.

1. As an administrator, log on to the machine hosting the Session Recording Server.
2. In IIS Manager, click **Application Pools**.
3. In **Application Pools**, right-click **SessionRecordingLoggingAppPool** and choose **Advanced Settings**.
4. Change the attribute **identity** to the specific account that you want to use.
5. Grant the **db_owner** permission to the account for the database **CitrixSessionRecordingLogging** on Microsoft SQL Server.
6. Grant the read permission to the account for the registry key at **HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server**.

**Disable or enable the recording action logging**

By default, Administrator Logging logs every recording action after the policy query completes. This case might generate a large amount of loggings. To improve the performance and save the storage, disable this kind of logging in Registry.

1. As an administrator, log on to the machine hosting the Session Recording Server.
2. Open the Registry Editor.
3. Browse to **HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server**.
4. Set the value of **EnableRecordingActionLogging** to:
   - **0**: disable the recording action logging
   - **1**: enable the recording action logging

**Query the Administrator Logging data**

Session Recording provides a web-based UI to query all Administrator Logging data.

On the computer hosting the Session Recording Server:
1. From the Start menu, choose Session Recording Administrator Logging.
2. Type the credentials of a LoggingReader user.

On other computers:

1. Open a web browser and visit the webpage for Administrator Logging.
   - For HTTPS: https://servername/SessionRecordingLoggingWebApplication/, where servername is the name of the machine hosting the Session Recording Server.
   - For HTTP: http://servername/SessionRecordingLoggingWebApplication/, where servername is the name of the machine hosting the Session Recording Server.
2. Type the credentials of a LoggingReader user.

**Database high availability**

July 5, 2018

Session Recording supports the following solutions for database high availability based on Microsoft SQL Server. The databases can automatically fail over when the hardware or software of a principal or primary SQL Server fails, which ensures that Session Recording continues to work as expected.

- **Always On Availability Groups**

- **SQL Server clustering**
  The Microsoft SQL clustering technology allows one server to automatically take over the tasks and responsibilities of the server that has failed. However, setting up this solution is complicated and the automatic failover is typically slower than alternatives such as SQL Server database mirroring. For more information, see [https://msdn.microsoft.com/en-us/library/ms189134.aspx](https://msdn.microsoft.com/en-us/library/ms189134.aspx).

- **SQL Server database mirroring**
  Database mirroring ensures that an automatic failover occurs in seconds if the active database server fails. This solution is more expensive than the other two solutions because full SQL Server licenses are required on each database server. You cannot use the SQL Server Express edition in a mirrored environment. For more information, see [https://msdn.microsoft.com/en-us/library/ms189852.aspx](https://msdn.microsoft.com/en-us/library/ms189852.aspx).
Methods for configuring Session Recording with database high availability

To configure Session Recording with database high availability, do either of the following:

- Install the Session Recording Server components first and then configure database high availability for the created databases.

  You can install the Session Recording Administration components with databases configured to be installed on the prepared SQL Server instance. Then, configure database high availability for the created databases.
  
  - For Always On Availability Groups and clustering, you must manually change the SQL Server instance name to the name of the availability group listener or SQL Server network in HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\SmAudDatabaseInstance.
  
  - For database mirroring, you must manually add the failover partners for databases in HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\DatabaseFailoverPartner and HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\LoggingDatabaseFailoverPartner.

- Configure database high availability for empty databases first and then install the Session Recording Administration components.

  You can create two empty databases as the Session Recording Database and the Administrator Logging Database in the expected primary SQL Server instance and configure high availability.

  Then enter the SQL Server instance name when installing the Session Recording Server components:
  
  - To use the Always On Availability Groups solution, enter the name of your availability group listener.
  
  - To use the database mirroring solution, enter the name of your principal SQL Server.
  
  - To use the clustering solution, enter the network name of your SQL Server.

Load balancing

November 13, 2019

This feature is to support load balancing across the Session Recording Servers. To use this feature, configure load balancing on Citrix ADC so that the Session Recording Servers can achieve load balancing and automatic failover.

An enhancement has been achieved that some load balancing configurations can be synchronized among all Session Recording Servers.

Note:

This feature requires Version 7.16 or later of the Session Recording Server and Session Recording
Agent.

Changes to Session Recording in support of load balancing:

- All Session Recording Servers share the same folder to store recording files.
- All Session Recording Servers share the same Session Recording Database.
- (Recommended) Install only one Session Recording Policy Console component and all Session Recording Servers share this Console.

Configure load balancing

To use this feature, perform the following steps on Citrix ADC and on the various Session Recording components:

Configure load balancing (Citrix ADC part)

Configure load balancing servers

Add the Session Recording Servers to the load balancing servers in Citrix ADC.

Configure load balancing services

1. Add a load balancing service for each needed protocol on each Session Recording Server.
2. (Recommended) Select the relevant protocol monitor to bind each service monitor.

Configure load balancing virtual servers

1. Create virtual servers with the same Citrix ADC VIP address based on the needed protocols and bind the virtual servers to the relevant load balancing services.
2. Configure persistence on each virtual server.
3. (Recommended) Choose LEASTBANDWITH or LEASTPACKETS as the load balancing method rather than the default method (LEASTCONNECTION).
4. Create a certificate to make the HTTPS virtual server UP.

Configure load balancing (Session Recording part)

On each server where you installed the Session Recording Server, do the following

1. (Recommended) Type the same Session Recording Database name during the Session Recording Server installation.
2. If you choose the Administrator Logging feature, Citrix recommends that you type the same Administrator Logging Database name when you install each Session Recording Server.
3. After sharing the Read/Write permission of the file storage folder with all Session Recording Server machine accounts, change to use the file storage folder as the shared folder in Session Recording Server Properties. For more information, see Specify where recordings are restored.

4. Add a value to the Session Recording Server registry key at HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.
   Value name: EnableLB
   Value data: 1 (D_WORD, meaning enable)

5. If you choose the HTTP or the HTTPS protocol for the Session Recording Storage Manager message queue, create a Host for the Citrix ADC VIP address, add redirection in C:\Windows\System32\msmq\Mapping\sample_map, and restart the Message Queuing service.
   The redirection is similar to:

   ```xml
   <directions xmlns="msmq-queue-redirections.xml">
       <redirection>
           <from>http://<ADCHost>*/msmq/private$/CitrixSmAudData</from>
           <to>http://<LocalFqdn>/msmq/private$/CitrixSmAudData</to>
       </redirection>
       <redirection>
           <from>https://<ADCHost>*/msmq/private$/CitrixSmAudData</from>
           <to>https://<LocalFqdn>/msmq/private$/CitrixSmAudData</to>
       </redirection>
   </directions>
   ```
   Where `<ADCHost>` is the created FQDN of the Citrix ADC VIP address, and `<LocalFqdn>` is the FQDN of the local host.

6. (Recommended) After configuring one Session Recording Server registry, you can use the following script to export configurations from this Server registry and import the registry to the other Session Recording Server registries. You can also use the script to add redirection mapping for message queue.

   ```bash
   # Copyright (c) Citrix Systems, Inc. All rights reserved.
   #
   .SYNOPSIS
   This script is used to sync configurations between Session Recording Servers for load balancing deployment.
   
   .DESCRIPTION
   ```
Will do below kinds of actions:

1. Export values from the registry key: HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server to SrServerConfig.reg;

2. Import from SrServerConfig.reg and overwrite values in registry key: HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server;

3. Add redirection mapping sr_lb_map.xml in %windir%\System32\msmq\mapping;

3.1 sr_lb_map.xml will consist redirection rule for both http and https, and not port specific.

.PARAMETER Action

Export - to export the registry configurations of Session Recording Server to a registry file

Import - to import the registry configurations of Session Recording Server from a registry file

AddRedirection - to add HTTP/HTTPS redirection for MSMQ

.PARAMETER ADCHost

The host name or FQDN of Citrix ADC.

.OUTPUTS

Exported configuration file (SrServerConfig.reg) or backup configuration file (SrServerConfig.reg.bk)

.EXAMPLE

SrServerConfigurationSync.ps1 -Action Export

.EXAMPLE

SrServerConfigurationSync.ps1 -Action Import

.EXAMPLE
SrServerConfigurationSync.ps1 -Action AddRedirection -ADCHost netscaler.xd.local

.EXAMPLE

SrServerConfigurationSync.ps1 -Action Import,AddRedirection -ADCHost netscaler.xd.local

.EXAMPLE

SrServerConfigurationSync.ps1 -Action Import,Export,AddRedirection -ADCHost netscaler.xd.local

#>

$SR_SERVER_REG_PATH = "HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server"

$REG_FILE_PATH      = "SrServerConfig.reg"
$REG_BACKUP_FILE_PATH = "SrServerConfig.reg.bk"

$TEMP_REDIRECT_XML = "sr_lb_map.xml"

$REDIRECT_XML_PATH = "$env:windir\System32\msmq\mapping"

Try
{
    If ($Action -Contains "export") {

        Write-Host "Exporting current Session Recording Server Configuration to registry file: $REG_FILE_PATH ..." -ForegroundColor Green

        & REG EXPORT $SR_SERVER_REG_PATH $REG_FILE_PATH /Y

        Write-Host "Finish exporting." -ForegroundColor Green

    }}

    If ($Action -Contains "import")
{

        If (!(Test-Path $REG_FILE_PATH))
{

            Write-Host "No $REG_FILE_PATH founded. Aborted." -ForegroundColor Yellow

            Exit 0
        }

    }

© 1999-2020 Citrix Systems, Inc. All rights reserved.
# Back up previous registry key

Write-Host "Backing up Session Recording Server Configuration to Registry file: $REG_BACKUP_FILE_PATH ..." -ForegroundColor Green

& REG EXPORT $SR_SERVER_REG_PATH $REG_BACKUP_FILE_PATH /Y

Write-Host "Importing Session Recording Server Configuration from Registry file: $REG_FILE_PATH ..." -ForegroundColor Green

& REG IMPORT $REG_FILE_PATH 2>$null

Write-Host "Finish importing." -ForegroundColor Green

} }

If ($Action -Contains "addredirection")

{

# Check if Citrix ADC host is given; If not, exit normally with warning.

If(([String]::IsNullOrEmpty($ADCHost)))

{

Write-Host "No Citrix ADC host name is specified. Finish adding redirection." -ForegroundColor Yellow

Exit 0

}

If (!((Test-Path $TEMP_REDIRECT_XML))}
New-Item $TEMP_REDIRECT_XML -Type file

$SysInfo = Get-WmiObject -Class Win32_ComputerSystem
$LocalFqdn = "$(SysInfo.Name).$(SysInfo.Domain)"
$RedirectXmlContent = ""

<redirections xmlns="msmq-queue-redirections.xml">
    <redirection>
        <from>http://$ADCHost*/msmq/private$/CitrixSmAudData</from>
        <to>http://$LocalFqdn/msmq/private$/CitrixSmAudData</to>
    </redirection>
    <redirection>
        <from>https://$ADCHost*/msmq/private$/CitrixSmAudData</from>
        <to>https://$LocalFqdn/msmq/private$/CitrixSmAudData</to>
    </redirection>
</redirections>

# Don't take care of encoding
$RedirectXmlContent | Out-File -FilePath $TEMP_REDIRECT_XML

Write-Host "Copying $TEMP_REDIRECT_XML to $REDIRECT_XML_PATH ..." -ForegroundColor Green

Copy-Item $TEMP_REDIRECT_XML -Destination $REDIRECT_XML_PATH

Write-Host "Restarting MSMQ service ..." -ForegroundColor Green

Restart-Service msmq -Force

Write-Host "Finish adding HTTP/HTTPS Redirection for MSMQ." -ForegroundColor Green

}

Exit 0

}

Catch

{

Write-Host "$_.Exception.Message" -ForegroundColor Red

Exit 1

}

Finally

{

# Nothing to do

}
6a. Save the preceding sample code as a PowerShell script, for example, SrServerConfigurationSync.ps1.

6b. On one Session Recording Server, after configuring the EnableLB registry value, start a command prompt as an administrator and run the `powershell.exe -file SrServerConfigurationSync.ps1 -Action Export,AddRedirection -ADCHost <ADCHost>` command, where `<ADCHost>` is the created FQDN of the Citrix ADC VIP address.

6c. After the script executes, an exported registry file named SrServerConfig.reg is generated and an `sr_lb_map.xml` file is added to the `C:\Windows\System32\msmq\Mapping` path.

6d. On other Session Recording Servers, copy SrServerConfig.reg generated in the preceding step, start a command prompt as an administrator, and run the `powershell.exe -file SrServerConfigurationSync.ps1 -Action Import,AddRedirection -ADCHost <ADCHost>` command, where `<ADCHost>` is the created FQDN of the Citrix ADC VIP address.

6e. After the script executes, the EnableLB value is added to the other Session Recording Server registry keys and an `sr_lb_map.xml` file is added to the `C:\Windows\System32\msmq\Mapping` path.

**On the machine where you installed the Session Recording Agent, do the following in Session Recording Agent Properties**

- If you choose the HTTP or the HTTPS protocol for the Session Recording Storage Manager message queue, type the FQDN of the Citrix ADC VIP address in the **Session Recording Server** text box.
- If you choose the default TCP protocol for the Session Recording Storage Manager message queue, type the Citrix ADC VIP address in the **Session Recording Server** text box.

**On the machine where you installed the Session Recording Player, do the following**

Add the Citrix ADC VIP address or its FQDN as the connected Session Recording Server.

**On the SQL Server where you installed the Session Recording Database, do the following**

Add all the Session Recording Server machine accounts to the shared Session Recording Database and assign them with the **db_owner** permission.

**Change your communication protocol**

November 9, 2018
For security reasons, Citrix does not recommend using HTTP as a communication protocol. The Session Recording installation is configured to use HTTPS. To use HTTP instead of HTTPS, you must change several settings.

Use HTTP as the communication protocol

1. Log on to the machine hosting the Session Recording Server and disable secure connections for Session Recording Broker in IIS.
2. Change the protocol setting from HTTPS to HTTP in Session Recording Agent Properties on each server where the Session Recording Agent is installed:
   a) Log on to each server where the Session Recording Agent is installed.
   b) From the Start menu, choose Session Recording Agent Properties.
   c) In Session Recording Agent Properties, choose the Connections tab.
   d) In the Session Recording Broker area, select HTTP from the Protocol drop-down list and click OK to accept the change. If you are prompted to restart the service, click Yes.
3. Change the protocol setting from HTTPS to HTTP in the Session Recording Player settings:
   a) Log on to each workstation where the Session Recording Player is installed.
   b) From the Start menu, choose Session Recording Player.
   c) From the Session Recording Player menu bar, choose Tools > Options > Connections, select the server, and choose Modify.
   d) Select HTTP from the Protocol drop-down list and click OK twice to accept the change and exit the dialog box.
4. Change the protocol setting from HTTPS to HTTP in the Session Recording Policy Console:
   a) Log on to the server where the Session Recording Policy Console is installed.
   b) From the Start menu, choose Session Recording Policy Console.
   c) Select HTTP from the Protocol drop-down list and click OK to connect. If the connection is successful, this setting is remembered the next time you start the Session Recording Policy Console.

Revert to HTTPS as the communication protocol

1. Log on to the machine hosting the Session Recording Server and enable secure connections for the Session Recording Broker in IIS.
2. Change the protocol setting from HTTP to HTTPS in Session Recording Agent Properties on each server where the Session Recording Agent is installed:
   a) Log on to each server where the Session Recording Agent is installed.
   b) From the Start menu, choose Session Recording Agent Properties.
   c) In Session Recording Agent Properties, choose the Connections tab.
d) In the **Session Recording Broker** area, select **HTTPS** from the **Protocol** drop-down list and click **OK** to accept the change. If you are prompted to restart the service, click **Yes**.

3. Change the protocol setting from HTTP to HTTPS in the Session Recording Player settings:
   a) Log on to each workstation where the Session Recording Player is installed.
   b) From the **Start** menu, choose **Session Recording Player**.
   c) From the **Session Recording Player** menu bar, choose **Tools > Options > Connections**, select the server, and choose **Modify**.
   d) Select **HTTPS** from the **Protocol** drop-down list and click **OK** twice to accept the change and exit the dialog box.

4. Change the protocol setting from HTTP to HTTPS in the Session Recording Policy Console:
   a) Log on to the server where the Session Recording Policy Console is installed.
   b) From the **Start** menu, choose **Session Recording Policy Console**.
   c) Select **HTTPS** from the **Protocol** drop-down list and click **OK** to connect. If the connection is successful, this setting is remembered the next time you start the Session Recording Policy Console.

**Configure CEIP**

November 13, 2019

When you participate in the **Citrix Customer Experience Improvement Program (CEIP)**, anonymous configuration and usage data is collected and sent to Citrix to help improve the product quality and performance. In addition, a copy of the anonymous data is sent to Google Analytics (GA) for fast and efficient analysis.

**Settings**

**CEIP setting**

By default, you automatically participate in CEIP when you install Session Recording. The first upload of data occurs approximately seven days after you install Session Recording. To unsubscribe from CEIP, do the following:

1. Log on to the machine hosting the Session Recording Server.
2. From the **Start** menu, choose **Session Recording Server Properties**.
3. In **Session Recording Server Properties**, click the **CEIP** tab.
4. Clear the **Participate in the Customer Experience Improvement Program** check box.
5. Restart the **Citrix Session Recording Analytics Service** to make the setting take effect.

**GA setting**

When GA is enabled, the heartbeat data between GA and the Session Recording Server is collected every 5 hours.

Registry setting that enables or disables GA (default = 0):

Location: `HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server`  
Name: `CeipHeartBeatDisable`  
Value: `1` = disabled, `0` = enabled  

When unspecified, GA is enabled.

To disable GA:

1. Log on to the machine hosting the Session Recording Server.
2. Open the **Registry Editor**.
3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server. 

4. Add a registry value and name it CeipHeartBeatDisable. 

5. Set the value data of CeipHeartBeatDisable to 1. 

6. Restart the Citrix Session Recording Analytics Service to make the setting take effect. 

**Data collected from the Session Recording Server**

The following table gives an example of the types of anonymous information collected. The data does not contain any details that identify you as a customer. 

<table>
<thead>
<tr>
<th>Data Point</th>
<th>Key Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine GUID</td>
<td>machine_guid</td>
<td>Identifying the machine where the data originates. When GA is enabled, the heartbeat data is sent to GA regardless of whether CEIP is enabled.</td>
</tr>
<tr>
<td>Operating System version</td>
<td>OS_version</td>
<td>Text string denoting the machine's operating system. When GA is enabled, the heartbeat data is sent to GA regardless of whether CEIP is enabled.</td>
</tr>
<tr>
<td>Session Recording Server version</td>
<td>SRS_version</td>
<td>Text string denoting the installed version of the Session Recording Server. When GA is enabled, the heartbeat data is sent to GA regardless of whether CEIP is enabled.</td>
</tr>
<tr>
<td>Number of application recordings</td>
<td>application-recording-number</td>
<td>Integer denoting the number of application recording files. The data is sent when both GA and CEIP are enabled.</td>
</tr>
<tr>
<td>Data Point</td>
<td>Key Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Number of recordings</td>
<td>recording-number</td>
<td>Integer denoting the number of both application and desktop recording files. The data is sent when both GA and CEIP are enabled.</td>
</tr>
<tr>
<td>Number of dynamic recordings</td>
<td>dynamic-recording-number</td>
<td>Integer denoting the number of dynamically recorded files. The data is sent when both GA and CEIP are enabled.</td>
</tr>
<tr>
<td>Number of agents hosting recorded sessions</td>
<td>recorded-agent-number</td>
<td>Integer denoting the number of VDAs hosting recorded sessions. The data is sent when both GA and CEIP are enabled.</td>
</tr>
<tr>
<td>Number of agents hosting recorded sessions containing logged events</td>
<td>event-logging-enabled-agent-number</td>
<td>Integer denoting the number of VDAs hosting recorded sessions that contain logged events. The data is sent when both GA and CEIP are enabled.</td>
</tr>
<tr>
<td>Number of recordings containing logged events</td>
<td>event-logging-recording-number</td>
<td>Integer denoting the number of recording files that contain logged events. The data is sent when both GA and CEIP are enabled.</td>
</tr>
<tr>
<td>Administrator logging enablement</td>
<td>admin-logging-status</td>
<td>Digit indicating the enablement of administrator logging. “1” means enabled. “0” means disabled. The data is sent when both GA and CEIP are enabled.</td>
</tr>
<tr>
<td>Number of logged events</td>
<td>collected-events-number</td>
<td>Integer denoting the number of logged events. The data is sent when both GA and CEIP are enabled.</td>
</tr>
</tbody>
</table>
### Data Point

<table>
<thead>
<tr>
<th>Data Point</th>
<th>Key Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of custom policies</td>
<td>customized-policies-number</td>
<td>Integer denoting the number of custom session recording and event logging policies. The data is sent when both GA and CEIP are enabled.</td>
</tr>
<tr>
<td>Load balancing enablement</td>
<td>load-balancing-status</td>
<td>Digit indicating the enablement of load balancing. “1” means enabled. “0” means disabled. The data is sent when both GA and CEIP are enabled.</td>
</tr>
<tr>
<td>Recording viewing policy enablement</td>
<td>rbac-status</td>
<td>Digit indicating the enablement of recording viewing policies. “1” means enabled. “0” means disabled. The data is sent when both GA and CEIP are enabled.</td>
</tr>
</tbody>
</table>

### Log events

**December 18, 2019**

Session Recording can log events and tag events in recordings for later search and playback. You can easily search for events of interest from large amounts of recordings and can locate the events during playback in the Session Recording Player.

### Events that can be logged

Session Recording can log the following events:

- Insertion of USB mass storage devices
- Application starts and ends
- File renaming, creation, deletion, and moving operations
- Web browsing activities
• Top-most window activities

**Insertion of USB mass storage devices**

Session Recording can log the insertion of a Client Drive Mapping (CDM) mapped or generic redirected USB mass storage device in a client device where Citrix Workspace app for Windows or for Mac is installed, and can tag the event in the recording.

**Note:**
Currently, only the insertion of USB mass storage devices (USB Class 08) can be logged. To make the feature work as expected, upgrade the Session Recording Administration components and the Session Recording Agent to Version 1811 or later. For more information, see [Event logging policies](#).

**Application starts and ends**

Session recording supports the logging of both application starts and ends. When you add a process to the **App monitoring list**, applications driven by the added process and its child processes are all monitored.

**Note:**
To make the feature work as expected, upgrade the Session Recording Administration components and the Session Recording Agent to Version 1811 or later. For more information, see [Event logging policies](#).

**File renaming, creation, deletion, and moving operations**

You can log file or subfolder renaming, creation, deletion, and moving operations in target folders, and tag the events in the recording. For more information, see [Event logging policies](#).

**Note:**
To make the feature work as expected, upgrade all Session Recording components including the Session Recording Administration components, the Session Recording Agent, and the Session Recording Player to Version 1903 or later.

**Web browsing activities**

You can log user activities on supported browsers and tag the events in the recording. The browser name, URL, and page title are logged. For an example, see the following screen capture.
Session Recording 2003

**Events and Bookmarks**

<table>
<thead>
<tr>
<th>Time</th>
<th>Activity</th>
</tr>
</thead>
</table>

When you move your cursor away from a webpage that has focus, your browsing of this webpage is tagged without showing the browser name. This feature can be used to estimate how long a user stays on a webpage. For an example, see the following screen capture.

**List of supported browsers:**

<table>
<thead>
<tr>
<th>Browser</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chrome</td>
<td>69 and later</td>
</tr>
<tr>
<td>Internet Explorer</td>
<td>11</td>
</tr>
<tr>
<td>Firefox</td>
<td>61 and later</td>
</tr>
</tbody>
</table>

**Note:**

To make the feature work as expected, upgrade the Session Recording Administration components and the Session Recording Agent to Version 1906 or later. For more information, see Event logging policies.

**Top-most window activities**

Session Recording can log top-most window activities and tag the events in the recording. The process name, title, and process number are logged.
The Session Recording Player allows you to perform advanced searches for recordings with tagged events.

1. In the Session Recording Player, click **Advanced Search** on the tool bar or choose **Tools > Advanced Search**.
2. Define your search criteria in the **Advanced Search** dialog box.

The **Events** tab allows you to search for tagged events in sessions by **Event text** and/or **Event type**. You can use the **Events**, **Common**, **Data/Time**, and **Other** filters in combination to search for recordings that meet your criteria.

---

**Search for and play back recordings with tagged events**

**Search for recordings with tagged events**

<table>
<thead>
<tr>
<th>Event Time</th>
<th>Event Type</th>
<th>Process</th>
<th>File Name</th>
<th>Description</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:56:08 AM</td>
<td>Top-most window</td>
<td>EXCEL</td>
<td>Book2</td>
<td></td>
<td>5830</td>
</tr>
<tr>
<td>1:56:22 AM</td>
<td>Top-most window</td>
<td>explorer, CITRIXINSTALLATION CGS</td>
<td></td>
<td></td>
<td>7212</td>
</tr>
<tr>
<td>1:56:35 AM</td>
<td>Top-most window</td>
<td>Taskmgr, CitISVCS.exe</td>
<td></td>
<td></td>
<td>5276</td>
</tr>
<tr>
<td>1:56:39 AM</td>
<td>Top-most window</td>
<td>explorer, Application.svtx</td>
<td></td>
<td></td>
<td>7212</td>
</tr>
<tr>
<td>1:56:55 AM</td>
<td>Top-most window</td>
<td>notepad++, .doc</td>
<td></td>
<td></td>
<td>4940</td>
</tr>
<tr>
<td>1:56:59 AM</td>
<td>Top-most window</td>
<td>explorer, Desktop</td>
<td></td>
<td></td>
<td>7212</td>
</tr>
<tr>
<td>1:57:03 AM</td>
<td>Top-most window</td>
<td>WINWORD, Bjjgjsbb j.docx</td>
<td></td>
<td></td>
<td>8936</td>
</tr>
<tr>
<td>1:57:13 AM</td>
<td>Top-most window</td>
<td>notepad++, .doc</td>
<td></td>
<td></td>
<td>4940</td>
</tr>
<tr>
<td>1:57:20 AM</td>
<td>Top-most window</td>
<td>Taskmgr, CitISVCS.exe</td>
<td></td>
<td></td>
<td>5276</td>
</tr>
<tr>
<td>1:57:34 AM</td>
<td>Top-most window</td>
<td>Taskmgr, CitrixAuthenicaion,VirtualSmartcard.exe</td>
<td></td>
<td></td>
<td>5276</td>
</tr>
<tr>
<td>1:57:51 AM</td>
<td>Top-most window</td>
<td>ieeedit, FileOperationMonitorList</td>
<td></td>
<td></td>
<td>6564</td>
</tr>
<tr>
<td>1:58:04 AM</td>
<td>Top-most window</td>
<td>notepad++, .shl</td>
<td></td>
<td></td>
<td>4940</td>
</tr>
<tr>
<td>1:58:25 AM</td>
<td>Top-most window</td>
<td>explorer, Task Switcher</td>
<td></td>
<td></td>
<td>7212</td>
</tr>
<tr>
<td>1:58:25 AM</td>
<td>Top-most window</td>
<td>EXCEL, Grid</td>
<td></td>
<td></td>
<td>6680</td>
</tr>
</tbody>
</table>
Note:

- The **Event type** list itemizes all event types that have been logged by Citrix Session Recording. You can select any one of the event types to search. Selecting **Any Citrix-defined event** means to search for all recordings with any type of events logged by Citrix Session Recording.
- The **Event text** filter supports partial match. Wildcards are not supported.
- The **Event text** filter is case-insensitive when matching.
Play back recordings with tagged events

When you play back a recording with events tagged, the events are present in the Events and Bookmarks panel and show as yellow dots in the lower part of the Session Recording Player as follows:

You can use events to navigate through a recorded session, or skip to the points where the events are tagged.

View recordings

August 10, 2018

Use the Session Recording Player to view, search, and bookmark recorded Citrix Virtual Apps and Desktops sessions.

If sessions are recorded with the live playback feature enabled, you can view sessions that are in progress, with a delay of 1-2 seconds, and sessions that are completed.

Sessions that have a longer duration or larger file size than the limits configured by your Session Recording administrator appear in more than one session file.

Note:

A Session Recording administrator must grant users the right to access the recorded sessions of VDAs. If you are denied access to viewing sessions, contact your Session Recording administrator.
When the Session Recording Player is installed, the Session Recording administrator typically sets up a connection between the Session Recording Player and a Session Recording Server. If this connection is not set up, the first time you perform a search for files, you are prompted to set it up. Contact your Session Recording administrator for setup information.

**Launch the Session Recording Player**

November 29, 2018

**Launch the Session Recording Player**

1. Log on to the workstation where the Session Recording Player is installed.

2. From the **Start** menu, choose **Session Recording Player**. The Session Recording Player appears.

This illustration shows the Session Recording Player with callouts indicating its major elements. The functions of these elements are described throughout the following articles.

![Session Recording Player Illustration](image)

**Display or hide window elements**

The Session Recording Player has window elements that toggle on and off.
1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose View.
4. Choose the elements that you want to display. Selecting an element causes it to appear immediately. A check mark indicates that the element is selected.

Connect to the desired Session Recording Server

If the Session Recording administrator sets up your Session Recording Player with the ability to connect to multiple Session Recording Servers, you can select the Session Recording Server that your Session Recording Player connects to. The Session Recording Player can connect to only one Session Recording Server at a time.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Tools > Options > Connections.
4. Select the Session Recording Server to which you want to connect.

Enable or disable live session playback and playback protection

Enable or disable live session playback

If sessions are recorded with the live playback feature enabled, you can view a session after or while it is being recorded. Viewing a session that is being recorded is similar to seeing actions happening live. However, there is actually a delay of 1-2 seconds when the data propagates from the VDA.

Some functionality is not available when you view sessions that are not recorded completely:

- A digital signature cannot be assigned until recording is complete. If digital signing is enabled, you can view live playback sessions, but they are not digitally signed and you cannot view certificates until the session is completed.
- Playback protection cannot be applied until recording is complete. If playback protection is enabled, you can view live playback sessions, but they are not encrypted until the session is completed.
- You cannot cache a file until recording is complete.

By default, live session playback is enabled.
1. Log on to the computer hosting the Session Recording Server.
2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Playback tab.
4. Select or clear the Allow live session playback check box.

**Enable or disable playback protection**

As a security precaution, Session Recording automatically encrypts recorded files before they are downloaded for viewing in the Session Recording Player. This playback protection prevents recorded files from being copied and viewed by anyone other than the user who downloaded the file. The files cannot be played back on another workstation or by another user. Encrypted files are identified with an .icle extension. Unencrypted files are identified with an .icl extension. The files remain encrypted while they reside in the cache on the workstation where the Session Recording Player is installed until they are opened by an authorized user.

Citrix recommends that you use HTTPS to protect the transfer of data.

By default, playback protection is enabled.

1. Log on to the machine hosting the Session Recording Server.
2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Playback tab.
4. Select or clear the Encrypt session recording files downloaded for playback check box.

**Open and play recordings**

February 1, 2019

**Open recordings**

You can open session recordings in the Session Recording Player in three ways:

- Perform a search using the Session Recording Player. Recorded sessions that meet the search criteria appear in the search results area.
- Access recorded session files directly from your local disk drive or a shared drive.
- Access recorded session files from a Favorites folder.

When you open a file that was recorded without a digital signature, a warning message appears telling you that the origin and integrity of the file were not verified. If you are confident of the integrity of the file, click Yes in the warning window to open the file.
Open a recording in the search results area

1. Log on to the machine where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. Perform a search.
4. If the search results area is not visible, select Search Results in the Workspace pane.
5. In the search results area, select the session you want to play.
6. Do any of the following:
   - Double-click the session.
   - Right-click and select Play.
   - From the Session Recording Player menu bar, choose Play > Play.

Open a recording by accessing the file

The name of a recorded session file begins with i_, followed by a unique alphanumeric file ID and then the .icl or .icle extension. The .icl extension denotes the recordings without playback protection applied. The .icle extension denotes the recordings with playback protection applied. Recorded session files are saved in a folder that incorporates the date the sessions were recorded. For example, the file for a session recorded on December 22, 2014, is saved in folder path 2014\12\22.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. Do any of the following:
   - From the Session Recording Player menu bar, choose File > Open and browse for the file.
   - Using Windows Explorer, navigate to the file and drag the file to the Player window.
   - Using Windows Explorer, navigate to and double-click the file.
   - If you created Favorites in the Workspace pane, select Favorites and open the file from the Favorites area in the same way you open files from the search results area.

Use favorites

Creating the Favorites folders allows you to quickly access recordings that you view frequently. These Favorites folders reference recorded session files that are stored on your workstation or on a network drive. You can import and export these files to other workstations and share these folders with other Session Recording Player users.
Note:
Only users with access rights to the Session Recording Player can download the recorded session files associated with the Favorites folders. Contact your Session Recording administrator for the access rights.

To create a Favorites subfolder:

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. In the Session Recording Player window, select the Favorites folder in your Workspace pane.
4. From the menu bar, choose File > Folder > New Folder. A new folder appears under the Favorites folder.
5. Type the folder name, then press Enter or click anywhere to accept the new name.

Use the other options that appear in the File > Folder menu to delete, rename, move, copy, import, and export the folders.

Play recordings

After you open a recorded session in the Session Recording Player, you can navigate through the recorded sessions using these methods:

- Use the player controls to play, stop, pause, and increase or decrease playback speed.
- Use the seek slider to move forward or backward.

If you have inserted markers to the recording or if the recorded session contains custom events, you can also navigate through the recorded session by going to those markers and events.

Note:

- During playback of a recorded session, a second mouse pointer might appear. The second pointer appears at the point in the recording when the user navigated within Internet Explorer and clicked an image that was originally larger than the screen but was scaled down automatically by Internet Explorer. While only one pointer appears during the session, two might appear during playback.
- This version of Session Recording does not support SpeedScreen Multimedia Acceleration and the Flash quality adjustment policy setting. When this option is enabled, playback displays a black square.
- When you record a session with a resolution higher than or equal to 4096 x 4096, there might be fragments in the recording appearance.
Use the player controls

You can click the player controls in the lower part of the Player window or access them by choosing Play from the Session Recording Player menu bar.

<table>
<thead>
<tr>
<th>Player Control</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Play icon]</td>
<td>Plays the selected session file.</td>
</tr>
<tr>
<td>![Pause icon]</td>
<td>Pauses playback.</td>
</tr>
<tr>
<td>![Stop icon]</td>
<td>Stops playback. If you click Stop, then Play, the recording restarts at the beginning of the file.</td>
</tr>
<tr>
<td>![Fast forward icon]</td>
<td>Halves the current playback speed down to a minimum of one-quarter of the normal speed.</td>
</tr>
<tr>
<td>![Fast reverse icon]</td>
<td>Doubles the current playback speed up to a maximum of 32 times the normal speed.</td>
</tr>
</tbody>
</table>

Use the seek slider

Use the seek slider in the lower part of the Player window to jump to a different position within the recorded session. You can drag the seek slider to the point in the recording you want to view or click anywhere on the slider bar to move to that location.

You can also use the following keyboard keys to control the seek slider:

<table>
<thead>
<tr>
<th>Keyboard Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>Seeks to the beginning.</td>
</tr>
<tr>
<td>End</td>
<td>Seeks to the end.</td>
</tr>
<tr>
<td>Right Arrow</td>
<td>Seeks forward five seconds.</td>
</tr>
<tr>
<td>Left Arrow</td>
<td>Seeks backward five seconds.</td>
</tr>
<tr>
<td>Move mouse wheel one notch down</td>
<td>Seeks forward 15 seconds.</td>
</tr>
<tr>
<td>Move mouse wheel one notch up</td>
<td>Seeks backward 15 seconds.</td>
</tr>
<tr>
<td>Ctrl + Right Arrow</td>
<td>Seeks forward 30 seconds.</td>
</tr>
<tr>
<td>Ctrl + Left Arrow</td>
<td>Seeks backward 30 seconds.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Seeks forward one minute.</td>
</tr>
<tr>
<td>Keyboard Key</td>
<td>Function</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>Page Up</td>
<td>Seeks backward one minute.</td>
</tr>
<tr>
<td>Ctrl + Move mouse wheel one notch down</td>
<td>Seeks forward 90 seconds.</td>
</tr>
<tr>
<td>Ctrl + Move mouse wheel one notch up</td>
<td>Seeks backward 90 seconds.</td>
</tr>
<tr>
<td>Ctrl + Page Down</td>
<td>Seeks forward six minutes.</td>
</tr>
<tr>
<td>Ctrl + Page Up</td>
<td>Seeks backward six minutes.</td>
</tr>
</tbody>
</table>

To adjust the speed of the seek slider: From the **Session Recording Player** menu bar, choose **Tools > Options > Player** and drag the slider to increase or decrease the seek response time. A faster response time requires more memory. The response might be slow depending on the size of the recordings and your machine’s hardware.

**Change the playback speed**

You can set the Session Recording Player to play recorded sessions in exponential increments from one-quarter normal playback speed to 32 times normal playback speed.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the **Start** menu, choose **Session Recording Player**.
3. From the **Session Recording Player** menu bar, choose **Play > Play Speed**.
4. Choose a speed option.

The speed adjusts immediately. Text indicating the exponential rate appears briefly in green in the lower part of the Player window.

**Highlight the idle periods of recorded sessions**

Idle periods of a recorded session are the portions in which no action takes place. The Session Recording Player can highlight the idle periods of recorded sessions during playback. The option is **On** by default. For more information, see **Highlight idle periods**.

**Skip over spaces where no action occurred**

Fast review mode allows you to set Session Recording Player to skip the portions of recorded sessions in which no action takes place. This setting saves time for playback viewing. However, it does not skip animated sequences such as animated mouse pointers, flashing cursors, or displayed clocks with second hand movements.
1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Play > Fast Review Mode.

The option toggles on and off. Each time you choose it, its status appears briefly in green in the Player window.

**Change the playback display**

Options allow you to change how recorded sessions appear in the Player window. You can pan and scale the image, show the playback in full screen, display the Player window in a separate window, and display a red border around the recorded session to differentiate it from the Player window background.

**Display the Player window in full screen**

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose View > Player Full Screen.
4. To return to the original size, press Esc or F11.

**Display the Player window in a separate window**

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose View > Player in Separate Window. A new window appears containing the Player window. You can drag and resize the window.
4. To embed the Player window in the main window, choose View > Player in Separate Window, or press F10.

**Scale the session playback to fit the Player window**

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Play > Panning and Scaling > Scale to Fit.

   - **Scale to Fit (Fast Rendering)** shrinks images while providing good quality. Images are drawn quicker than using the High Quality option but the images and texts are not sharp. Use this option if you are experiencing performance issues when using the High Quality mode.
- **Scale to Fit (High Quality)** shrinks images while providing high quality. Using this option can cause the images to be drawn more slowly than the Fast Rendering option.

**Pan the image**

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Play > Panning and Scaling > Panning. The pointer changes to a hand. And a small representation of the screen appears in the top right of the Player window.
4. Drag the image. The small representation indicates where you are in the image.
5. To stop panning, choose one of the scaling options.

**Display a red border around Session Recording**

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Tools > Options > Player.
4. Select the Show border around session recording check box.
   If the Show border around session recording check box is not selected, you can temporarily view the red border by clicking and holding down the left mouse button while the pointer is in the Player window.

**Highlight idle periods**

July 5, 2018

Idle periods of a recorded session are the portions in which no action takes place. The Session Recording Player can highlight the idle periods of recorded sessions during playback. The option is **On** by default.

**Note:** Idle periods are not highlighted when playing back live sessions with the Session Recording Player.

To highlight the idle periods of recorded sessions, do the following:

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose View > Idle Periods and select or clear the check box.
Cache recordings

July 5, 2018

Each time you open a recorded session file, the Session Recording Player downloads the file from the location where the recordings are stored. If you download the same files frequently, you can save download time by caching the files on your workstation. Cached files are stored on your workstation in this folder:

```
C:\Users\username\AppData\Local\Citrix\SessionRecording\Player\Cache
```

You can specify how much disk space is used for the cache. When the recordings fill the specified disk space, Session Recording deletes the oldest, least used recordings to make room for new recordings. You can empty the cache at any time to free up disk space.

Enable caching

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Tools > Options > Cache.
4. Select the Cache downloaded files on local machine check box.
5. To limit the amount of disk space used for caching, select the Limit amount of disk space to use check box and specify the number of MB to be used for cache.
6. Click OK.

Empty caches

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Tools > Options > Cache.
4. Select the Cache downloaded files on local machine check box.
5. In the Session Recording Player, choose Tools > Options > Cache.
6. Click Purge Cache and OK to confirm the action.

Use events and bookmarks

October 26, 2018

You can use events and bookmarks to help you navigate through recorded sessions.
Citrix-defined events are inserted to sessions while the sessions are recorded. You can also use the Event API and a third-party application to insert custom events. Events are saved as part of the session file. You cannot delete or alter them using the Session Recording Player.

Bookmarks are markers you insert in a recorded session during session playback using the Session Recording Player. After insertion, bookmarks are associated with the recorded session until you delete them. However, they are not saved as part of the session file but stored as separate “.iclb” files in the Bookmarks cache folder on the Session Recording Player, for example, C:\Users\SpecificUser\AppData\Local\Citrix\SessionRecording\Player\Bookmarks, with the same file name as the “.icl” recording file. To play back a recording using bookmarks on a different Player, copy the “.iclb” files to the Bookmarks cache folder on that Player. By default, each bookmark is labeled with the text “Bookmark,” but you can change this to any text annotation up to 128 characters long.

Events appear as yellow dots and bookmarks appear as blue squares in the lower part of the Player window. Moving the mouse over the dots and squares displays the text label associated with them. You can also display the events and bookmarks in the Events and Bookmarks list of the Session Recording Player. They appear in this list with their text labels and the times in the recorded session at which they appear, in chronological order.

You can use events and bookmarks to help you navigate through recorded sessions. By going to an event or bookmark, you can skip to the point in the recorded session where the event or bookmark is inserted.

**Display events and bookmarks in the list**

The Events and Bookmarks list displays the events and bookmarks inserted in the recorded session that is currently playing. It can show events only, bookmarks only, or both.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. Move the mouse pointer to the Events and Bookmarks list area and right-click to display the menu.
4. Choose Show Events Only, Show Bookmarks Only, or Show All.

**Insert a bookmark**

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. Begin playing the recorded session to which you want to add a bookmark.
4. Move the seek slider to the position where you want to insert the bookmark.
5. Move the mouse pointer to the Player window area and right-click to display the menu.
6. Add a bookmark with the default **Bookmark** label or create an annotation:
   - To add a bookmark with the default **Bookmark** label, choose **Add Bookmark**.
   - To add a bookmark with a descriptive text label that you create, choose **Add Annotation**.
     Type the text label you want to assign to the bookmark, up to 128 characters. Click **OK**.

**Add or change an annotation**

After a bookmark is created, you can add an annotation to it or change its annotation.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the **Start** menu, choose **Session Recording Player**.
3. Begin playing the recorded session containing the bookmark.
4. Ensure that the **Events and Bookmarks** list is displaying bookmarks.
5. Select the bookmark in the **Events and Bookmarks** list and right-click to display the menu.
6. Choose **Edit Annotation**.
7. In the window that appears, type the new annotation and click **OK**.

**Delete a bookmark**

1. Log on to the workstation where the Session Recording Player is installed.
2. From the **Start** menu, choose **Session Recording Player**.
3. Begin playing the recorded session containing the bookmark.
4. Ensure that the **Events and Bookmarks** list is displaying bookmarks.
5. Select the bookmark in the **Events and Bookmarks** list and right-click to display the menu.
6. Choose **Delete**.

**Go to an event or bookmark**

Going to an event or bookmark causes the Session Recording Player to go to the point in the recorded session where the event or bookmark is inserted.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the **Start** menu, choose **Session Recording Player**.
3. Begin playing a session recording containing events or bookmarks.
4. Go to an event or bookmark:
   - In the lower part of the Player window, click the dot or square representing the event or bookmark to go to the event or bookmark.
   - In the **Events and Bookmarks** list, double-click the event or bookmark to go to it. To go to the next event or bookmark, select any event or bookmark from the list, right-click to display the menu, and choose **Seek to Bookmark**.

© 1999-2020 Citrix Systems, Inc. All rights reserved.
Search for recordings

November 27, 2019

The Session Recording Player allows you to perform quick and advanced searches and to specify options that apply to all searches. Results of searches appear in the search results area of the Session Recording Player.

Note:

To display all available recorded sessions, up to the maximum number of sessions that might appear in a search, perform a search without specifying any search parameters.

Perform a quick search

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. Define your search criteria:
   • Enter a search criterion in the Search field.
   • Move the mouse pointer over the Search label to display a list of parameters to use as a guideline.
   • Click the arrow to the right of the Search field to display the text for the last 64 searches you performed.
   • Use the drop-down list to the right of the Search field to select a period or duration specifying when the session was recorded.
4. Click the binocular icon to the right of the drop-down list to start the search.

Perform an advanced search

Advanced searches might take up to 20 seconds to return results containing more than 150,000 entities. Citrix recommends using more accurate search conditions such as a date range or user to reduce the result number.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. In the Session Recording Player window, click Advanced Search on the tool bar or choose Tools > Advanced Search.
4. Define your search criteria on the tabs of the Advanced Search dialog box:
- **Common** allows you to search by domain or account authority, site, group, VDA for multi-session OS, application, or file ID.
- **Date/Time** allows you to search date, day of week, and time of day.
- **Events** allows you to search for Citrix-defined and custom events that are inserted to the sessions.
- **Other** allows you to search by session name, client name, client address, and recording duration. It also allows you to specify, for this search, the maximum number of search results displayed and whether archived files are included in the search. When you specify search criteria, the query you are creating appears in the pane at the bottom of the dialog box.

5. Click **Search** to start the search.

You can save and retrieve advanced search queries. Click **Save** in the **Advanced Search** dialog box to save the current query. Click **Open** in the **Advanced Search** dialog box to retrieve a saved query. Queries are saved as files with an .isq extension.

### Set search options

The Session Recording Player search options allow you to limit the maximum number of session recordings that appear in search results and to specify whether search results include archived session files.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the **Start** menu, choose **Session Recording Player**.
3. From the **Session Recording Player** menu bar, choose **Tools > Options > Search**.
4. In the **Maximum result to display** field, type the number of search results you want to display.
   
   A maximum of 500 results can be displayed.
5. To set whether archived files are included in searches, select or clear **Include archived files**.

### Session Recording web player

April 16, 2020

**Overview**

The web player lets you use a web browser to view and play back recordings, and configure cache memory for storing recordings while playing. Using the web player, you can:
• Search for recordings by using filters, including host name, client name, user name, application, client IP address, event text, event type, and time. For more information, see the View recordings section in this article.

• View and play back both live and completed recordings with tagged events listed in the right pane. For more information, see the View recordings section in this article.

**Note:**
Internet Explorer, Google Chrome, and Firefox are supported.
An error occurs when you attempt to play recordings by using the web player in Internet Explorer. For more information, see Known issues.

### Enable the web player

The web player is enabled by default.

- To disable the web player, start a Windows command prompt and run the `<Session Recording Server installation path>\Bin\TestPolicyAdmin.exe –disablewebplayer` command.
- To enable the web player, start a Windows command prompt and run the `<Session Recording Server installation path>\Bin\TestPolicyAdmin.exe -enablewebplayer` command.

### Logon and password

The URL of the web player website is `http(s)://<FQDN of Session Recording Server>/WebPlayer`. To ensure the use of HTTPS, add an SSL binding to the website on IIS and update the `SSRecWebSock-etServer.config` configuration file. For more information, see the HTTPS configuration section in this article.

**Note:**
When logging on to the web player website, domain users do not need to enter credentials while non-domain users must.

After you log on to the web player website, all recordings appear, listed. Clicking All Recordings in the left navigation refreshes the page and displays new recordings if there are any.
Installation

As with the other Session Recording components, you can use the Citrix Virtual Apps and Desktops installer to install the web player.

During installation, selecting Session Recording Administration on the Core Components page installs the web player on the same machine with the Session Recording Server. For more information about installing Session Recording, see Install, upgrade, and uninstall.

With the web player installed, the SessionRecordingRestApiService and the WebPlayer applications appear on IIS.
HTTPS configuration

To use HTTPS to access the web player website:

1. Add an SSL binding on IIS.

   a) Obtain an SSL certificate in PEM format from a trusted Certificate Authority (CA).

   **Note:**

   Most popular browsers such as Google Chrome and Firefox no longer support common name in a Certificate Signing Request (CSR). They enforce Subject Alternative Name (SAN) in all publicly trusted certificates. To use the web player over HTTPS, take the following actions accordingly:

   • When a single Session Recording Server is in use, update the certificate of the Session Recording Server to a SAN certificate.
• When load balancing is in use, ensure that a SAN certificate is available both on Citrix ADC and each Session Recording Server.

b) On IIS, right-click the website and select **Add Bindings**. The **Site Bindings** dialog box appears.
c) Click **Add** in the upper right corner. The **Add Site Binding** dialog box appears.

d) Select **https** from the **Type** list and select your SSL certificate.

![Add Site Binding dialog box](image)

```
Type:  
http  
http  
https
```

Example: www.contoso.com or marketing.contoso.com

![Add Site Binding dialog box](image)

```
Type:  
https  
Port:  
443
```

```
Host name: 

 Require Server Name Indication

SSL certificate: 
Not selected
Not selected
```

![Add Site Binding dialog box](image)

e) Click **OK**.

2. Update the **SsRecWebSocketServer.config** configuration file.

a) Locate and open the **SsRecWebSocketServer.config** configuration file.

   The **SsRecWebSocketServer.config** configuration file is typically located in the `<Session Recording Server installation path>`\Bin\ folder.
b) Enable TLS by editing TLSEnable=1, and fill in the paths to the SSL certificate and its key, respectively.

Note:
Only the PEM format of SSL certificates and key files is supported. The ServerPort field indicates the port number that the web player uses to collect recording files. In the following screen capture, it is set to the default value (22334).

To extract separate certificate and key files used in the WebSocket server configuration:

i. Ensure that OpenSSL is installed on your Session Recording Server that contains the SSL certificate.

ii. Export the SSL certificate as a .pfx file. The .pfx file includes both the certificate and the private key.

iii. Open the command prompt and go to the folder that contains the .pfx file.

iv. Start OpenSSL from the OpenSSL\bin folder.

v. Run the following command to extract the certificate:

```bash
openssl pkcs12 -in [yourfile.pfx] -clcerts -nokeys -out [aSRS2.pem]
```

Enter the import password that you created when exporting the .pfx file.

vi. Run the following command to extract the private key:

```bash
openssl pkcs12 -in [yourfile.pfx] -nocerts -out [newaSRS2keyWithPassword.pem]
```
Enter the import password that you created when exporting the .pfx file. Provide a new password for protecting your key file when prompted for the PEM pass phrase.

vii. Run the following command to decrypt the private key:

```
openssl rsa -in [newaSRS2keyWithPassword.pem] -out [newaSRS2key.pem]
```

c) Save your changes.
d) Check your firewall settings. Allow SsRecWebSocketServer.exe to use the TCP port (22334 by default) and allow access to the web player URL.
e) Run the TestPolicyAdmin –stopwebsocketserver command.

**View recordings**

After you log on to the web player, all available recordings are listed. You can scroll down the webpage to select recordings to view or use filters to customize your search results. For live recordings, the **Duration** item shows **Live** and the play button appears green.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time</td>
<td>The recording start time. Click the up and down arrows to list recordings in chronological order.</td>
</tr>
</tbody>
</table>
### Session Recording 2003

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>The user whose session was recorded. Click the up and down arrows to concentrate recordings of a user on the list and arrange users in alphabetical order.</td>
</tr>
<tr>
<td>Host</td>
<td>The host name of the VDA where the recorded session was hosted. Click the up and down arrows to arrange the VDA host names in alphabetical order.</td>
</tr>
<tr>
<td>Client</td>
<td>The name of the client device where the session was running. Click the up and down arrows to arrange the client host names in alphabetical order.</td>
</tr>
<tr>
<td>Events</td>
<td>The quantity of events in the recording. Click the up and down arrows to arrange recordings on the list by event quantity.</td>
</tr>
<tr>
<td>Duration</td>
<td>The time length of the recording. Click the up and down arrows to arrange recordings on the list by time length.</td>
</tr>
</tbody>
</table>

#### Search for recordings by using filters

You can search for recordings by using filters. The available filters include host name, client name, user name, application, client IP address, event text, event type, and time.

For example, after you select the host name filter, the following dialog box appears. Type in the host name (of the VDA where recorded sessions are hosted) and click **Search** to filter out irrelevant record-
ings and display only the relevant ones.

You can change to a different filter by clicking the currently selected **Host name**, as shown in the following screen capture. All filters are listed after you click **Host name**. Select a different filter as needed.

You can also click the + symbol to add filters.

For example, you can add the **Time** filter as shown in the following screen.

The **Time** filter consists of recording start date, start time, and duration.
Open and play recordings

On the recordings page, each recording has a play button on the right side, next to the **Duration** item.

Click the play button. The playback page appears. Playback starts after memory caching.

For a description of the player controls, see the following table:

<table>
<thead>
<tr>
<th>Player Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play</td>
<td>Plays the selected recording file.</td>
</tr>
<tr>
<td>Pause</td>
<td>Pauses playback.</td>
</tr>
</tbody>
</table>
## Session Recording 2003

<table>
<thead>
<tr>
<th>Player Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="pause.png" alt="Pause" /> <img src="play.png" alt="Play" /></td>
<td>You can drag the progress bar during playback. Idle periods of recorded sessions are highlighted during playback.</td>
</tr>
<tr>
<td><img src="seek-back.png" alt="Seek Back" /></td>
<td>Seeks backward 7 seconds.</td>
</tr>
<tr>
<td><img src="time.png" alt="Time" /></td>
<td>Indicates the current position of the recording playback and the total recording duration. The time format is HH:MM:SS.</td>
</tr>
<tr>
<td><img src="comments.png" alt="Comments" /></td>
<td>Lets you click and leave a comment about the recording being played.</td>
</tr>
<tr>
<td><img src="speed.png" alt="Speed" /></td>
<td>Indicates the current speed of playback. Click the icon to switch between options including X0.5, X1, X2, and X4.</td>
</tr>
<tr>
<td><img src="full-screen.png" alt="FullScreen" /></td>
<td>Displays the playback in full screen.</td>
</tr>
<tr>
<td><img src="narrow.png" alt="Narrow" /></td>
<td>Displays the playback within the webpage.</td>
</tr>
</tbody>
</table>

In the right pane of the playback page, the following recording data, event filters, and the quick search box are available:
The date and time on the web player machine. In this example, February 21, 2020 and 18:32:24.

The duration of the recording in playback. In this example, 00:09:12.

The number of events in the recording. In this example, 9 EVENTS.

The name of the user whose session was recorded.

The hostname of the VDA where the recorded session was hosted.

The name of the client device where the session was running.

Options for sorting search results: Select Sort by All Categories, Sort by Events, or Sort by Comments to sort search results.

Event filters. You can select more than one filter to search for events in the current recording.
Click the icon to expand folded displays of events.

- Event list. Clicking an event on the list takes you to the position of the event in the recording.
- Quick search box. The search events quick search box helps to quickly narrow down a list of events in the current recording.

**Configure cache memory for storing recordings while playing**

On the Configuration page of the web player, click the slider to set up the cache memory for storing recordings while playing.
Record idle events and highlight idle periods

Session Recording can record idle events and highlight idle periods in the Session Recording web player. Idle events are not visible in the Session Recording Player because idle events are saved in the Session Recording Database but not in the relevant recording files (.icl files).

To customize the idle event feature, set the following registry keys as required. The registry keys are located at HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SessionEvents.

<table>
<thead>
<tr>
<th>Registry key</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DisableIdleEvent</td>
<td>0</td>
<td>To disable the idle event feature, set the value to 1. To enable the idle event feature, set the value to 0.</td>
</tr>
<tr>
<td>IdleEventThrottle</td>
<td>120 seconds</td>
<td>If there is no user activity (including graphics changes and keyboard/mouse inputs) longer than the time threshold set by the registry key, an idle event is recorded and the idle period is highlighted when the recorded session plays back on the Session Recording web player.</td>
</tr>
</tbody>
</table>
## Session Recording 2003

<table>
<thead>
<tr>
<th>Registry key</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IdleEventActiveThrottle</td>
<td>30 seconds</td>
<td>Only a certain number of graphics changes within a specified amount of time qualify as user activities. By default, at least three packets within 30 seconds can qualify as user activities.</td>
</tr>
<tr>
<td>IdleEventActivePktNumThrottle</td>
<td>3 packets</td>
<td>Only a certain number of graphics changes within a specified amount of time qualify as user activities. By default, at least three packets within 30 seconds can qualify as user activities.</td>
</tr>
<tr>
<td>IdleEventActivePktSizeThrottle</td>
<td>100 bytes</td>
<td>Graphics packets smaller than the key value are ignored and the relevant time duration is regarded as idle.</td>
</tr>
</tbody>
</table>

### Comment on recordings

When a recorded session is being played, you can click the **Comments** player control to leave comments and set the comment severities. Comments of different severities are displayed in different colors in the right event list panel. Severities include Normal, Medium, and Severe. During session playback, you can view all comments about a recording and delete comments from the event list. Refresh the webpage before being able to delete a comment you just left.
Clicking a comment in the event list lets you jump to the location where the comment was given. Clicking the comment icon in the upper left corner redirects you to the My comments page where all your comments are presented.

Note:
To make the comment feature work as expected, clear the WebDAV Publishing check box in the Add Roles and Features wizard of Server Manager on the machine where the Session Recording Server is installed.
The troubleshooting information contains solutions to some issues you might encounter during or after installing the Session Recording components.

**Warning:**
Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the registry before you edit it.

Installation of Server components fails

July 5, 2018

The installation of the Session Recording Server components fails with error codes 2503 and 2502. Resolution: Check the access control list (ACL) of folder C:\windows\Temp to ensure that the Local Users and Groups have write permission for this folder. If not, manually add write permission.

Test connection to the Database fails during install

July 5, 2018

When you install the Session Recording Database or the Session Recording Server, the test connection fails with the error message Database connection test failed. Please correct Database instance name even if the database instance name is correct.

In this case, ensure that the current user has the public SQL Server role permission to correct the permission limitation failure.

Agent cannot connect to the Server

February 1, 2019

When the Session Recording Agent cannot connect to the Session Recording Server, the Exception caught while sending poll messages to Session Recording Broker event message is logged, followed by the exception text. The exception text provides reasons why the connection failed. The reasons include:

- The underlying connection was closed. Could not establish a trust relationship for the SSL/TLS secure channel. This exception means that the Session Recording Server is using a certificate signed by a CA that the server hosting the Session Recording Agent does not trust or the server hosting the Session Recording Agent does not have a CA certificate. Alternatively, the certificate might have expired or been revoked.
Solution: Verify that the correct CA certificate is installed on the server hosting the Session Recording Agent or use a CA that is trusted.

- **The remote server returned an error: (403) forbidden.** This is a standard HTTPS error displayed when you attempt to connect using HTTP (nonsecure protocol). The machine hosting the Session Recording Server rejects the connection because it accepts only secure connections.

  Solution: Use Session Recording Agent Properties to change the Session Recording Broker protocol to HTTPS.

- **The Session Recording Broker returned an unknown error while evaluating a record policy query. Error code 5 (Access Denied).** For more information, see the Event log on the Session Recording Server. This error occurs when sessions are started and a request for a record policy evaluation is made. The error is a result of the Authenticated Users group (this is the default member) being removed from the Policy Query role of the Session Recording Authorization Console.

  Solution: Add the Authenticated Users group back to this role, or add each server hosting each Session Recording Agent to the PolicyQuery role.

- **The underlying connection was closed. A connection that was expected to be kept alive was closed by the server.** This error means that the Session Recording Server is down or unavailable to accept requests. The IIS might be offline or restarted, or the entire server might be offline.

  Solution: Verify that the Session Recording Server is started, IIS is running on the server, and the server is connected to the network.

- **The remote server returned an error: 401 (Unauthorized).** This error manifests itself in the following ways:
  - On startup of the Session Recording Agent Service, an error describing the 401 error is recorded in the event log.
  - Policy query fails on the Session Recording Agent.
  - Session recordings are not captured on the Session Recording Agent.

  Solution: Ensure that the **NT AUTHORITY\Authenticated Users** group is a member of the local **Users** group on the Session Recording Agent.
Server cannot connect to the Database

November 9, 2018

When the Session Recording Server cannot connect to the Session Recording Database, you might see a message similar to one of the following:

**Event Source:**

A network-related or instance-specific error occurred while establishing a connection to SQL Server. This error appears in the applications event log with ID 2047 in the Event Viewer of the computer hosting the Session Recording Server.

**Citrix Session Recording Storage Manager Description:** Exception caught while establishing database connection. This error appears in the applications event log in the Event Viewer of the machine hosting the Session Recording Server.

**Unable to connect to the Session Recording Server. Ensure that the Session Recording Server is**
running. This error message appears when you launch the Session Recording Policy Console.

Resolution:

• The Express Edition of Microsoft SQL Server 2008 R2, Microsoft SQL Server 2012, Microsoft SQL Server 2014, or Microsoft SQL Server 2016 is installed on a stand-alone server and does not have the correct services or settings configured for Session Recording. The server must have TCP/IP protocol enabled and SQL Server Browser service running. See the Microsoft documentation for information about enabling these settings.
• During the Session Recording installation (administration portion), incorrect server and database information was given. Uninstall the Session Recording Database and reinstall it, supplying the correct information.
• The Session Recording Database Server is down. Verify that the server has connectivity.
• The machine hosting the Session Recording Server or the machine hosting the Session Recording Database Server cannot resolve the FQDN or NetBIOS name of the other. Use the ping command to verify that the names can be resolved.
• Check the firewall configuration on the Session Recording Database to ensure that the SQL Server connections are allowed. For more information, see the Microsoft article at [https://msdn.microsoft.com/en-us/library/cc646023.aspx](https://msdn.microsoft.com/en-us/library/cc646023.aspx).

Logon failed for user ‘NT\_AUTHORITY\ANONYMOUS LOGON’. This error message means that the services are logged on incorrectly as \administrator.

Resolution: Restart the services as local system user and restart the SQL services.

Sessions are not recording

November 27, 2019

If your application sessions are not being recorded successfully, start by checking the application event log in the Event Viewer on the VDA for multi-session OS that runs the Session Recording Agent and Session Recording Server. Doing so can provide valuable diagnostic information.

If sessions are not being recorded, the possible cause might be:

• Component connectivity and certificates. If the Session Recording components cannot communicate with each other, session recording can fail. To troubleshoot recording issues, verify that all components are configured correctly to point to the correct machines and that all certificates are valid and correctly installed.
• Non-Active Directory domain environments. Session Recording is designed to run in a Microsoft Active Directory domain environment. If you are not running in an Active Directory environment, you might experience recording issues. Ensure that all Session Recording components are running on machines that are members of an Active Directory domain.
• **Session sharing conflicts with the active policy.** Session Recording matches the active policy with the first published application that a user opens. Subsequent applications opened during the same session continue to follow the policy that is in force for the first application. To prevent session sharing from conflicting with the active policy, publish the conflicting applications on separate VDAs for multi-session OS.

• **Recording is not enabled.** By default, installing the Session Recording Agent on a multi-session OS VDA enables recording for the VDA. Recording does not occur until an active recording policy is configured to allow it.

• **The active recording policy does not permit recording.** A session can be recorded only when the session meets the rules of the active recording policy.

• **Session Recording services are not running.** For sessions to be recorded, the Session Recording Agent service must be running on a VDA for multi-session OS and the Session Recording Storage Manager service must be running on the machine hosting the Session Recording Server.

• **MSMQ is not configured.** If MSMQ is not correctly configured on the server running the Session Recording Agent and the machine hosting the Session Recording Server, recording problems might occur.

### Unable to view live session playback

**July 5, 2018**

If you experience difficulties when viewing recordings using the Session Recording Player, the following error message might appear:

**Download of recorded session file failed. Live session playback is not permitted. The server has been configured to disallow this feature.** This error indicates that the server is configured to disallow the action.

Resolution: In [Session Recording Server Properties](#), choose the **Playback** tab and select the **Allow live session playback** check box.

### Recordings are corrupted or incomplete

**November 13, 2019**

• If recordings are corrupted or incomplete when you view them using the Session Recording Player, you might also see warnings in the Event logs on the Session Recording Agent.

  **Event Source:** Citrix Session Recording Storage Manager
**Description:** Data lost while recording file `<icl file name>`

This issue happens when MCS or PVS is used to create VDAs with a master image configured and Microsoft Message Queuing (MSMQ) installed. In this condition, the VDAs have the same QMId for MSMQ.

As a workaround, create a unique QMId for each VDA. For more information, see Install, upgrade, and uninstall.

- The Session Recording Player might report an internal error with the message - “The file being played has reported that an internal system error (error code: 9) occurred during its original recording. The file can still be played up to the point that the recording error occurred” when playing back a certain recording file.

This issue is caused by insufficient Session Recording Agent buffer size when recording graphic intensive sessions.

As a workaround, change HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SmAudBufferSizeMB to higher value data on the Session Recording Agent, and then restart the machine.

---

**Verify component connections**

November 27, 2019

During the setup of Session Recording, the components might not connect to other components. All the components communicate with the Session Recording Server (Broker). By default, the Broker (an IIS component) is secured using the IIS default website certificate. If one component cannot connect to the Session Recording Server, the other components might also fail when attempting to connect.

The Session Recording Agent and Session Recording Server (Storage Manager and Broker) log connection errors in the applications event log in the Event Viewer of the machine hosting the Session Recording Server, while the Session Recording Policy Console and Session Recording Player display connection error messages on screen when they fail to connect.

**Verify that the Session Recording Agent is connected**

1. Log on to the server where the Session Recording Agent is installed.
2. From the Start menu, choose Session Recording Agent Properties.
3. In Session Recording Agent Properties, click Connection.
4. Verify that the correct FQDN is entered in the Session Recording Server field.
5. Verify that the server given as the value for the Session Recording Server can be contacted by your VDA for multi-session OS.
Note: Check the application event log for errors and warnings.

Verify that the Session Recording Server is connected

Caution: Using Registry Editor can cause serious problems that might require you to reinstall the operating system. Citrix cannot guarantee that problems resulting from incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk.

1. Log on to the machine hosting the Session Recording Server.
2. Open the Registry Editor.
3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.
4. Verify that the SmAudDatabaseInstance value correctly references the Session Recording Database you installed on your SQL Server instance.

Verify that the Session Recording Database is connected

1. Using a SQL Management tool, open your SQL instance that contains the Session Recording Database you installed.
2. Open the Security permissions of the Session Recording Database.
3. Verify that the Session Recording Computer Account has access to the database. For example, if the machine hosting the Session Recording Server is named SsRecSrv in the MIS domain, the computer account in your database must be configured as MIS\SsRecSrv$. This value is configured during the Session Recording Database installation.

Test IIS connectivity

Testing connections to the Session Recording Server IIS site by using a Web browser to access the Session Recording Broker webpage can help you determine whether problems with communication between Session Recording components stem from misconfigured protocol configuration, certification issues, or problems starting Session Recording Broker.

To verify IIS connectivity for the Session Recording Agent:

1. Log on to the server where the Session Recording Agent is installed.
2. Open a Web browser and type the following address:
   - For HTTPS: https://servername/SessionRecordingBroker/RecordPolicy.rem?wsdl, where servername is the name of the machine hosting the Session Recording Server.
   - For <HTTP: http://servername/SessionRecordingBroker/RecordPolicy.rem?wsdl, where servername is the name of the machine hosting the Session Recording Server.
3. If you are prompted for NT LAN Manager (NTLM) authentication, log on with a domain administrator account.

To verify IIS connectivity for the Session Recording Player:

1. Log on to the workstation where the Session Recording Player is installed.
2. Open a Web browser and type the following address:
   - For HTTPS: https://servername/SessionRecordingBroker/Player.rem?wsdl, where servername is the name of the machine hosting the Session Recording Server
   - For HTTP: http://servername/SessionRecordingBroker/Player.rem?wsdl, where servername is the name of the machine hosting the Session Recording Server
3. If you are prompted for NT LAN Manager (NTLM) authentication, log on with a domain administrator account.

To verify IIS connectivity for the Session Recording Policy Console:

1. Log on to the server where the Session Recording Policy Console is installed.
2. Open a Web browser and type the following address:
   - For HTTPS: https://servername/SessionRecordingBroker/PolicyAdministration.rem?wsdl, where servername is the name of the machine hosting the Session Recording Server
   - For HTTP: http://servername/SessionRecordingBroker/PolicyAdministration.rem?wsdl, where servername is the name of the machine hosting the Session Recording Server
3. If you are prompted for NT LAN Manager (NTLM) authentication, log on with a domain administrator account.

If you see an XML document within your browser, it verifies that the machine running the Session Recording Policy Console is connected to the machine hosting the Session Recording Server using the configured protocol.

Troubleshoot certificate issues

If you are using HTTPS as your communication protocol, the machine hosting the Session Recording Server must be configured with a server certificate. All component connections to the Session Recording Server must have root certificate authority (CA). Otherwise, attempted connections between the components fail.

You can test your certificates by accessing the Session Recording Broker webpage as you would when testing IIS connectivity. If you are able to access the XML page for each component, the certificates are configured correctly.

Here are some common ways certificate issues cause connections to fail:
• **Invalid or missing certificates.** If the server running the Session Recording Agent does not have a root certificate to trust the server certificate and cannot trust and connect to the Session Recording Server over HTTPS, causing connectivity to fail, verify that all components trust the server certificate on the Session Recording Server.

• **Inconsistent naming.** If the server certificate assigned to the machine hosting the Session Recording Server is created using an FQDN, all connecting components must use the FQDN when connecting to the Session Recording Server. If a NetBIOS name is used, configure the components with a NetBIOS name for the Session Recording Server.

• **Expired certificates.** If a server certificate expired, connectivity to the Session Recording Server through HTTPS fails. Verify the server certificate assigned to the machine hosting the Session Recording Server is valid and has not expired. If the same certificate is used for the digital signing of session recordings, the event log of the machine hosting the Session Recording Server provides error messages that the certificate expired or warning messages when it is about to expire.

---

**Search for recordings using the Player fails**

November 9, 2018

If you experience difficulties when searching for recordings using the Session Recording Player, the following error messages might appear:

• **Search for recorded session files failed. The remote server name could not be resolved:** servername. The servername is the name of the server to which the Session Recording Player is attempting to connect. The Session Recording Player cannot contact the Session Recording Server. Two possible reasons are an incorrectly typed server name or that the DNS cannot resolve the server name.

Resolution: From the Player menu bar, choose **Tools > Options > Connections** and verify that the server name in the **Session Recording Servers** list is correct. If it is correct, from a command prompt, run the ping command to see if the name can be resolved. When the Session Recording Server is down or offline, the search for recorded session files failed error message is **Unable to contact the remote server**.

• **Unable to contact the remote server.** This error occurs when the Session Recording Server is down or offline.

Resolution: Verify that the Session Recording Server is connected.

• **Access denied.** An access denied error can occur if the user was not given permission to search for and download recorded session files.
Resolution: Assign the user to the Player role using the Session Recording Authorization Console.

- **Access denied when the Player role is assigned.** This error occurs when you install the Session Recording Player on the same machine with the Session Recording Server, and you have enabled UAC. When you assign the Domain Admins or Administrators user group as the Player role, a non-built-in administrator user who is included in that group might fail to pass the role-based check when searching recording files with the Session Recording Player.

  Resolutions:
  - Run Session Recording Player as administrator.
  - Assign specific users as Player role rather than the entire group.
  - Install Session Recording Player in a separate machine rather than Session Recording Server.

- **Search for recorded session files failed. The underlying connection was closed. Could not establish a trust relationship for the SSL/TLS secure channel.** This exception is caused by the Session Recording Server using a certificate that is signed by a CA that the client device does not trust or have a CA certificate for.

  Resolution: Install the correct or trusted CA certificate workstation where the Session Recording Player is installed.

- **The remote server returned an error: (403) forbidden.** This error is a standard HTTPS error that occurs when you attempt to connect using HTTP (nonsecure protocol). The server rejects the connection because, by default, it is configured to accept only secure connections.

  Resolution: From the Session Recording Player menu bar, choose Tools > Options > Connections. Select the server from the Session Recordings Servers list, and click Modify. Change the protocol from HTTP to HTTPS.

**Troubleshoot MSMQ**

If a notification message is given but the viewer cannot find recordings after a search in the Session Recording Player, there is a problem with MSMQ. Verify that the queue is connected to the Session Recording Server (Storage Manager). Use a Web browser to test for connection errors (if you are using HTTP or HTTPS as your MSMQ communication protocol).

To verify that the queue is connected:

1. Log on to the server hosting the Session Recording Agent and view the outgoing queues.
2. Verify that the queue to the machine hosting the Session Recording Server has a connected state.
• If the state is **waiting to connect**, there are messages in the queue, and the protocol is HTTP or HTTPS (corresponding to the protocol selected on the Connections tab in Session Recording Agent Properties), perform Step 3.
• If the state is **connected** and there are no messages in the queue, there might be a problem with the server hosting the Session Recording Server. Skip Step 3 and perform Step 4.

3. If there are messages in the queue, open a Web browser and type the following address:
   • For HTTPS: https://servername/msmq/private$/CitrixSmAudData, where server-name is the name of the machine hosting the Session Recording Server.
   • For HTTP: http://servername/msmq/private$/CitrixSmAudData, where server-name is the name of the machine hosting the Session Recording Server.

   If the page returns an error such as **The server only accepts secure connections**, change the MSMQ protocol listed in Session Recording Agent Properties to HTTPS. If the page reports a problem with the website security certificate, there might be a problem with a trust relationship for the TLS secure channel. In that case, install the correct CA certificate or use a CA that is trusted.

4. If there are no messages in the queue, log on to the machine hosting the Session Recording Server and view private queues. Select citrixsmauddata. If there are messages in the queue (Number of Messages Column), verify that the Session Recording StorageManager service is started. If it is not, restart the service.

### Manage your database records

October 18, 2018

The ICA Log database (ICLDB) utility is a database command-line utility used to manipulate the session recording database records. This utility is installed during the Session Recording installation in the drive:\Program Files\Citrix\SessionRecording\Server\Bin directory at the server hosting the Session Recording Server software.

### Quick reference chart

The following table lists the commands and options that are available for the ICLDB utility. Type the commands using the following format:

```
icl\d [version | locate | dormant | import | archive | remove | removeall] command-options [/l] [/f] [/s] [/?]
```
Note:
More extensive instructions are available in the help associated with the utility. To access the help, from a command prompt, type drive: \Program Files\Citrix\SessionRecording\Server\Bin directory, type icldb /?. To access help for specific commands, type icldb command /?.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>archive</td>
<td>Archives the session recording files older than the retention period specified. Use this command to archive files.</td>
</tr>
<tr>
<td>dormant</td>
<td>Displays or counts the session recording files that are considered dormant. Dormant files are session recordings that were not completed due to data loss. Use this command to verify if you suspect that you are losing data. You can check whether the session recording files are becoming dormant for the entire database, or only recordings made within the specified number of days, hours, or minutes.</td>
</tr>
<tr>
<td>import</td>
<td>Imports session recording files to the Session Recording database. Use this command to rebuild the database if you lose database records. Also, use this command to merge databases (if you have two databases, you can import the files from one of the databases).</td>
</tr>
<tr>
<td>locate</td>
<td>Locates and displays the full path to a session recording file using the file ID as the criteria. Use this command when you are looking for the storage location of a session recording file. It is also one way to verify if the database is up-to-date with a specific file.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>remove</td>
<td>Removes the references to session recording files from the database. Use this command (with caution) to clean up the database. Specify the retention period to be used as the criteria. You can also remove the associated physical file.</td>
</tr>
<tr>
<td>removeall</td>
<td>Removes all of the references to session recording files from the Session Recording Database and returns the database to its original state. The actual physical files are not deleted; however, you cannot search for these files in the Session Recording Player. Use this command (with caution) to clean up the database. Deleted references can be reversed only by restoring from your backup.</td>
</tr>
<tr>
<td>version</td>
<td>Displays the Session Recording Database schema version.</td>
</tr>
<tr>
<td>/l</td>
<td>Logs the results and errors to the Windows event log.</td>
</tr>
<tr>
<td>/f</td>
<td>Forces the command to run without prompts.</td>
</tr>
<tr>
<td>/s</td>
<td>Suppresses the copyright message.</td>
</tr>
<tr>
<td>/?</td>
<td>Displays help for the commands.</td>
</tr>
</tbody>
</table>

**Archive session recording files**

To maintain an adequate level of spare disk capacity in the recording storage locations, archive session recording files regularly. Depending on the amount of disk space available and the typical size of session recording files, archiving intervals differ. Session recording files must be older than two days from the start date before a session recording file can be archived. This rule is to prevent any live recordings from being archived before they become complete.

Two methods are available when you archive session recordings. The database record for a session recording file can be updated to have a status of archived while the session recording file remains in the recording storage location. This method can be used to reduce the search results in the Player. The other method is to update the database record for a session recording file to the status of archived and also move the session recording file from the recording storage location to another location for
backup to alternative media. When the ICLDB utility moves session recording files, the files are moved to the specified directory where the original file folder structure of year/month/day no longer exists.

The session recording record in the Session Recording Database contains two fields associated with archiving: the archive time representing the current date and time a session recording was archived; the archive note, an optional text note that might be added by the administrator during archiving. The two fields indicate a session recording has been archived and the time of archiving.

In the Session Recording Player, any archived session recordings show a status of Archived and the date and time of archiving. Session recordings that have been archived might still be played if the files have not been moved. If a session recording file was moved during archiving, a file not found error is displayed. The session recording file must be restored before the session can be played. To restore a session recording, provide the administrator with the File ID and Archive Time of the session recording from the recording Properties dialog box in the Session Recording Player. Restoring archived files is discussed further in the following Restore session recording files section.

The archive command of the ICLDB utility has several parameters that are described as follows:

- **/RETENTION:<days>** - The retention period in days for session recordings. Recordings older than the number of days specified are marked as archived in the Session Recording Database. The retention period must be an integer number greater than or equal to 2 days.

- **/LISTFILES** – Lists the full path and file name of session recording files as they are being archived. This is an optional parameter.

- **/MOVETO:<directory>** - The directory to which you physically move archived session recording files. The specified directory must exist. This is an optional parameter. If no directory is specified, files remain in their original storage location.

- **/NOTE:<note>** - A text note that is added to the database record for each session recording archived. Ensure that the note is enclosed with double quotes. This is an optional parameter.

- **/L** – Logs the results and errors to the Windows event log of the number of session recording files archived. This is an optional parameter.

- **/F** – Forces the archive command to run without prompts. This is an optional parameter.

**To archive session recordings in the Session Recording Database and physically move session recording files**

1. Log on to the server where the Session Recording Server is installed as a local administrator.
2. Start a command prompt.
3. Change from the current working directory to the Bin directory of the Session Recording Server installation path (<Session Recording Server Installation Path>/Server/Bin).
4. Run the `ICLDB ARCHIVE /RETENTION:<days> /LISTFILES /MOVETO:<directory> /NOTE:<note> /L` command where `days` is the retention period for session recording files, `directory` is the directory where archived session recording files are moved to, and `note` is the text note that is added to the database record for each session recording file being archived. Enter `Y` to confirm the archive.

**To only archive session recordings in the Session Recording Database**

1. Log on to the server where the Session Recording Server is installed as a local administrator.
2. Start a command prompt.
3. Change from the current working directory to the Bin directory of the Session Recording Server installation path (`<Session Recording Server Installation Path>/Server/Bin`).
4. Run the `ICLDB ARCHIVE /RETENTION:<days> /LISTFILES /NOTE:<note> /L` command where `days` is the retention period for session recordings and `note` is the text note that is added to the database record for each session recording being archived. Enter `Y` to confirm the archive.

**Restore session recording files**

Restoration of session recording files is required when you want to view a session recording that was archived in the Session Recording Database and the file has been moved from the recording storage location. Archived session recordings that were not moved from the recording storage location during archiving are still accessible in the Session Recording Player.

Two methods are available for restoring session recording files that have been moved. Copy the required session recording file to the restore directory for archived files, or import the required session recording file back to the Session Recording Database by using the ICLDB utility. Citrix recommends the first method for restoring archived session recording files. Remove archived files copied to the restore directory for archived files when you no longer need them.

The Session Recording Broker utilizes the **Restore directory for archived files** when a session recording file is not found in its original storage location. This case occurs when the Session Recording Player requests a session recording file for playback. The Session Recording Broker first attempts to find the session recording file in the original storage location. If the file is not found in the original storage location, the Session Recording Broker then checks the **Restore directory for archived files**. If the file is present in the restore directory, the Session Recording Broker sends the file to the Session Recording Player for playback. Otherwise, if the file is not found, the Session Recording Broker sends a file not found error to the Session Recording Player.

Importing archived session recording files by using the ICLDB utility updates the Session Recording Database with session recording information from the session recording file, including a new storage
path for the session recording file. Using the ICLDB utility to import an archived session recording file does not move the file back to the original storage location when the session was recorded.

**Note:** An imported session recording file has the archive time and archive note cleared in the Session Recording Database. Therefore, the next time the ICLDB archive command is run, the imported session recording file might become archived again.

The ICLDB import command is useful to import a large number of archived session recording files, repair, or update incorrect and missing session recording data in the Session Recording Database, or move session recording files from one storage location to another storage location on the Session Recording Server. The ICLDB `import` command can also be used to repopulate the Session Recording Database with session recordings after executing the ICLDB `removeall` command.

The import command of the ICLDB utility has several parameters that are described as follows:

- `/LISTFILES` – Lists the full path and file name of session recording files while they are being imported. This is an optional parameter.

- `/RECURSIVE` – Searches all subdirectories for session recording files. This is an optional parameter.

- `/L` – Logs the results and errors to the Windows event log the number of session recording files imported. This is an optional parameter.

- `/F` – Forces the import command to run without prompts. This is an optional parameter.

### To restore session recording files by using the restore directory for archived files

1. Log on to the server where the Session Recording Server is installed as a local administrator.

2. In Session Recording Player Properties, determine the File ID and Archive Time of the archived session recording file.

3. Locate the session recording file in your backups using the File ID specified in Session Recording Player Properties. Each session recording has a file name of `i_<FileID>.icl`, where FileID is the ID of the session recording file.

4. Copy the session recording file from your backup to the restore directory for archived files. To determine the restore directory for archived files:
   a) From the Start menu, choose **Start > All Programs > Citrix > Session Recording Server Properties**.
   b) In Session Recording Server Properties, select the Storage tab. The current restore directory appears in the **Restore directory for archived files** field.
To restore session recording files by using the ICLDB import command

1. Log on to the server where the Session Recording Server is installed as a local administrator.
2. Start a command prompt.
3. Change from the current working directory to the Bin directory of the Session Recording Server installation path (<Session Recording Server Installation Path>/Server/Bin).
4. Either:
   - Run the ICLDB IMPORT /LISTFILES /RECURSIVE /L <directory> command where directory is the name of one or more directories, separated by a space containing session recording files. Enter Y to confirm the import.
   - Run the ICLDB IMPORT /LISTFILES /L <file> command where file is the name of one or more session recording files, separated by a space. Wildcards might be used to specify session recording files. Enter Y to confirm the import.